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No other electronic reference work offers BOTH a rich source of information on the world AS WELL AS 
the most comprehensive resource ever created on Canada. The renowned Columbia Encyclopedia 
(complete edition) provides authoritative entries on world history, geography, social science, literature, 
etc. The Canadian Encyclopedia covers every conceivable Canadian topic, written for and by 
Canadians. This is not a reference work prepared in the United States and adapted for sale in the 
Canadian market. When you look for the entry on Painting or Newspapers or Constitution or Sport, the 
entire focus is on Canada, not just a few sentences.

In addition to two complete encyclopedias, The 1998 Canadian & World Encyclopedia also includes the
complete Gage Canadian Dictionary, a full French-English and English-French dictionary and a 
Thesaurus.

A Great Co-operative Venture
The Canadian Encyclopedia is in the best sense a work in progress as literally thousands of Canadians have 
contributed their ideas, suggestions and corrections to this national treasure.
§ over 3500 contributors from all parts of Canada
§ 400 consultants providing the highest level of scholarship
§ 17 years of research and editing
§ constant feedback from users all over Canada

A Multimedia Portrait of Canada
The 1998 Canadian & World Encyclopedia contains the broadest and most beautiful visual portrait of Canada ever
assembled, with thousands of photographs celebrating the Canadian landscape, Canadian art, history, animal and
plant diversity and the many faces of Canadian society and biography. Sensational video clips relive great 
moments in Canadian sport, politics, music and history. Hear Canadian writers such as Alice Munro and Al Purdy 
read their works in selected sound clips. Hear dozens of famous Canadian musicians, such as Glenn Gould and 
Ben Heppner performing.

Getting Help with the Program
This Quick Tour is intended to introduce you to the program. The Contents List (available through the Content Tab)
shows how most of the main topics are organized. Use the Index to find help on specific topics. Also, visit The 
Canadian Encyclopedia web site at http:www.tceplus.com for more information.



Quick Tour: What is New for 1998?

 The 1998 Canadian & World Encyclopedia
Tour Guide

 Click the right arrow to go to the next topic and the left arrow to go back.

 New interface
In response to numerous requests the encyclopedia interface is now “scalable”; that is, you can adjust the size of 
the encyclopedia window to suit your screen size and resolution. (See Scaling the Product Window for more 
information.) Various functions are now conveniently organized on toolbars.

 Life & Times of the Prime Ministers Disk
A brilliant multimedia treatment of the lives and times of Canada's prime ministers. (See Prime Ministers Disk in 
this Help program.)

 New Integrated Search
Just click the Contents Button to see a complete list of all the content on the disk. The traditional Boolean and 
Subject searches are still available as well as SmartSearch. (See Quick Tour: Searching.)

 Integrated Links between Articles and the Internet
Links from articles connect you directly through your Browser to the Internet. The links are updated monthly from 
The Canadian Encyclopedia web site and the links are integrated seamlessly with your program. (See Quick Tour: 
Internet Links.)

 Updates
Some 300 new articles and thousands of updated articles, including results from the 1996 Canadian census.

 New Multimedia
New video and pictures and one hour of new sounds.

 Expanded Timeline
The Timeline now includes over 4600 entries and two new categories: 100 Great Events in Canadian History and 
Birthdays of the Famous. (See Quick Tour: Timeline.)

 Expanded Quiz with Categories
200 new questions categorized so that you can test your knowledge of specific subjects such as Arts or History. 
(See Quick Tour: Quiz.)
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 Modes

The disk is organized in 5 modes: Encyclopedia, Dictionary, Media, Timeline and Quiz. Modes are arranged 
according to the various content of the disk.

 Functions
Functions allow users to manipulate or use the content on the disk. Most of the functions of the encyclopedia are 
found on the Toolbar or on menus.

 Filters
The filters are the keys to restricting or expanding contents lists. The Source Filters determine what content 
sources are viewed. The Media Filters control the lists of various types of media.

 Display Areas
The disk screens are generally organized with the Contents List of the left, which varies according to the function 
or mode. For example in the Dictionary Mode the list contains headwords, spelling alternatives or verb tenses. In 
Timeline Mode, it contains a list of events. In Encyclopedia Mode it contains a list of titles, according to the filters 
used.

The right side of the screen generally contains the text of an encyclopedia article or a dictionary entry.
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Every printed reference work contains so much more information than anyone can find. The electronic The 1998 
Canadian & World Encyclopedia provides unprecedented power to help you find the information in ways that suit 
you. 

Most exciting of the search tools in The 1998 Canadian & World Encyclopedia Is SmartSearch, which allows you 
to pose questions in common language. SmartSearch then ranks the answers in order and provides you with a 
preview of your key terms. Finding information has never been easier. How else could you search millions of 
words and tens of thousands of articles in a flash?

Contents
The Contents Button quickly produces a complete list of all the items on the disk, including the titles of articles in 
The Canadian Encyclopedia and the Columbia Encyclopedia, of Maclean’s articles, of entries in the Gage 
Canadian Dictionary and the French-English dictionary, of all the media and of the Timeline events. Use the 
Contents Button to see lists of titles of all the items on the disk. 

When the Contents Button is clicked, the Contents List shows the complete content of the disk. Use the Source 
Filters and the Media Filters to expand or limit the list.

To move through the Contents List 
1 Type a term in the Contents dialogue box
2 As you type, the list moves automatically down the list

Related Topic: QuickSearch.
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Expanding or Limiting the Contents List
Use the source filters to expand or restrict the Contents List. When you click the Contents Button, the entire 
contents of the disk are displayed in the list. Use the filters to display some or all of the contents.

 Click on the graphic above to identify the filters.

Click a filter to view the items from that source. For example, click on the Canadian Encyclopedia Filter to view the
list of entries from The Canadian Encyclopedia. The state of the source filter turns to on as in the following 
illustration. 

Viewing Content Items from More Than One Source
To view the items from more than one source, click the filters for those sources. In the following example, the filters
for The Canadian Encyclopedia, the Internet Links and the Timeline are on, displaying only the items from those 
three sources.

Note: Because of contractual arrangements, you cannot view the titles from the Columbia Encyclopedia 
alone.
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Expanding or Limiting the Types of Media
Use the media filters to expand or restrict the Contents List. When you click the Contents Button, the entire 
contents of the disk are displayed in the list. Use the media filters to display some or all of the media on the disk.

 Click on the graphic above to identify the media filters.

Click a filter to view the items from that media. For example, click on the Video Media Filter to view the list of all 
the videos and animations on the disk. The state of the media filter turns to on. 

To view the items of more than one type of media, click the filters for those media. In the following example, the 
filters for video, maps and sounds are on, displaying only those media in the Contents List.

Note: The Media Filters control both the list of media items AND a list of encyclopedia entries that contain
media. To view only the list of media, click the Media Source Filter.

Combining Filters
To see, for example, all the pictures in Timeline, click the Timeline Source Filter and the Picture Filter.
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There are 3 ways to search the entire contents of the disk:
1    SmartSearch. Use SmartSearch to perform general searches in which the program evaluates your search 
terms to find the best match for your query.

    See Quick Tour: SmartSearch 
2    Boolean Search. Use Boolean Search to perform word or phrase searches or to use the traditional Boolean 
operators: AND, OR, NOT and NEAR.
    See Quick Tour: Boolean Search 
3    Subject Search. Use Subject Search to find articles related to one another by subject, e.g., Birds
    See Quick Tour: Subject Search 



Quick Tour: SmartSearch

 The 1998 Canadian & World Encyclopedia
Tour Guide

 Click the right arrow to go to the next topic and the left arrow to go back.

Use SmartSearch to perform general searches in which the program evaluates your search terms to find the best 
match for your query

To activate SmartSearch

Click the SmartSearch Button 

Enter your query as a string of words or as a question in everyday language.

To refine your search, open the Tuner by clicking the Tuner Button and use the sliders to give greater or lesser 
importance to individual terms. (The tuner will include words related to the terms you have entered.)

Click here for help with the SmartSearch Screen and with the SmartSearch Window.

Note: In SmartSearch the results list is presented in the order in which the articles most closely matching 
your query appear at the top of the list. In Boolean searches, the results appear in alphabetical 
order.

Note: When you view an article from your results list, the section of the article containing the first match to
your term or terms is displayed highlighted in the text. Click on the pointer in the scroll bar to go to 
the next 

 
or previous 

 
match

 Click here for the SmartSearch Tutorial.
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Use Boolean Search to perform word or phrase searches or to use the traditional Boolean operators: AND, OR, 
NOT and NEAR.

To activate Boolean Search

Click the Boolean Search Button in the upper left of the Encyclopedia window.

Enter your search term

Enter additional terms, clicking a Boolean operator for each one
AND to find only those articles containing all your search terms
OR to find those articles with any one, or combinations of your terms
NOT to find any articles that exclude one or more terms
NEAR to find only those articles in which your terms appear close to one another

Use Advanced to enter your own Boolean operators. (The operators must be in capital letters.)

Click here for help with the Boolean Search Screen or the Boolean Advanced Screen.

Note: When you view an article from your results list, the section of the article containing the first match to
your term or terms is displayed highlighted in the text. Click on the pointer in the scroll bar to go to 
the next 

 
or previous 

 
match
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Use the Subject Index to find articles in the encyclopedias that are related to one another under common subject 
headings. (Many of the main subject headings lead to as many as 6 levels. See Subject Tree.)

To Find a Subject Heading
1      In Encyclopedia Mode, click the Subject Button on the Toolbar.
2      Choose whether you wish to Browse the subject tree or to Search the subject list by clicking the appropriate 
button.

 
to Browse the list

 
to Search the list

Note: You can display the articles in the same subject category as the current article by choosing Subject 
Links from the Related Menu.
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The easiest way to find multimedia is to
1    Double-click a multimedia title in the Contents List or on the Media Subject Browser list to activate the picture 
viewer

OR
2    Double click a thumbnail of a picture in the article text.

To return to the Encyclopedia Screen, click the Encyclopedia Tab.

To go to an associated article, click Go to Article on the Multimedia Menu.

To print, click the Print Button on the Toolbar.

To display a caption, click the Caption Button on the Toolbar.

To view the next or previous multimedia item in the list, click the    Next Button or Rewind Button on the Toolbar.

Activating Hotspots

To find hotspots on maps or pictures, move the mouse over the screen. When the cursor changes to a hand  and
the picture displays in reverse colours, click to view the hotspot.

Note: You must have 256-colour video drivers installed on your system for the optimum resolution of the 
illustrations. 
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The Dictionaries allow you to find definitions in English or French by entering your own terms or by simply double-
clicking on any word in the text of the encyclopedia articles.

To find a definition in the Dictionary

Enter Dictionary Mode by clicking the Dictionary Tab.

Click on the Dictionary Button on the Toolbar.

Choose Dictionary for English only.

Enter your term in the definition box.

Click the Definition Button.

To search for all dictionary entries that contain your term, click the SmartSearch or Boolean Search Button.

To find a translation in the Dictionary

Enter Dictionary Mode by clicking the Dictionary Tab.

Click on the Dictionary Button on the Toolbar.

Choose French-English or English-French.

Enter your term in the translation box.

Click the Translation Button.

To search for all dictionary entries that contain your term, click the Boolean or SmartSearch Button.

To look up a word directly from the text of the encyclopedias

Double click the word with the mouse.

To look up a word in the Thesaurus

Enter Dictionary Mode by clicking the Dictionary Tab.

Click the Thesaurus Button on the Toolbar.

Enter your term in the search box.

Click the Synonym Button. A list of synonyms appears.

To look up a word in both the Dictionary and Thesaurus

Click the Split Button on the Toolbar in Dictionary Mode.



 Click here to get detailed help on the Dictionary Screen.
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The Timeline includes over 4600 events in Canadian and world history, organized by Categories and Periods. The 
reader can search the events by date, find a list of Canadian firsts and view the Maclean's year in review entries.

How to Open the Timeline

To open the Timeline, click the Timeline Tab in the Encyclopedia, Dictionary, Media or Quiz modes or choose 
Timeline from the Navigation Menu.

Categories

Select Categories by clicking on the Category Button and then choosing a category from the Categories graphic. 
For example find a list of events describing Acts and Treaties by clicking on the Acts and Treaties box. 

Periods

Select Periods by clicking on the Periods Button and then choosing a period from the Periods graphic. For 
example find a list of events describing Early New France by clicking on the Early New France section of the 
Period graphic.

Note: Pointing the mouse to the right of the Category or Period graphics automatically moves the graphic 
without the scroll bar.

Other Functions

Click the Search by Date Button to search for events that happened on a certain day.

Click the Year in Review Button to view the Maclean's entries by month.

Click the On this Day Button to find events that happened on a certain day.

Click the Canadian Firsts Button to find descriptions of Canadian firsts.

 Click here for help on the Timeline Screen.

 Click here for more detailed help on the Timeline.
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Launch the encyclopedia quiz by clicking the Quiz Tab on the Encyclopedia, Dictionary, Media or Timeline Screen 
or by choosing Quiz from the Navigation Menu.

Click here to view the Quiz Screen.

Answering a Question

Answer a question by choosing the appropriate letter button associated with the question. If the answer is correct, 
a piece of the puzzle appears to the right, your score is registered on the scoreboard and a new question 
automatically appears. Click the New Question Button to display another question.

Getting a Clue

If you do not know the answer or want to find out more about the subject of the question, click the Clue Button to 
go to the relevant encyclopedia article.

Answering the Quiz in French or English

 Choose the language in which you want to answer the Quiz from the Question Menu.

Choosing a Quiz Category

 Choose the Category or Categories of questions from the Categories Menu. Choose All to answer questions from 
all categories.

Solving the Puzzle
When you have completed the quiz, you can try to solve the puzzle by moving the pieces with the mouse. The 
puzzle is similar to the small games with push tablets familiar to children. Click the Puzzle Hint Button to move one
piece or the Solve Button to solve the entire puzzle. The Jumble Button rescrambles the puzzle.



Quick Tour: Using and Updating Internet Links

 The 1998 Canadian & World Encyclopedia
Tour Guide

 Click the right arrow to go to the next topic and the left arrow to go back.

Internet links connect you to information on the World Wide Web. Each link is tied to one or more articles in The 
Canadian Encyclopedia.

To Find an Internet Link While Viewing an Article

 While displaying an encyclopedia article, choose Internet Links from the Related Menu. If the article contains 
links, they are listed as in the following example in the entry called Montreal Expos:

To Find a List of All the Internet Links
1    Click the Contents Button.
2    Click the Internet Link Source Filter.

To Follow an Internet Link
1 Choose the Internet Link using one of the two methods above.
2 Click the Connect Button.

To Update Your Internet Links
The World Wide Web changes daily, so many of the links provided on this disk may be inactive or may have 
changed address. The 1998 Canadian & World Encyclopedia provides an easy way to update your links every 
month.
1 From the File Menu, choose Get Internet Updates
2 If your Internet connection is currently open, the process will begin immediately. If you are not currently 

connected to your provider, the updater will automatically connect you and then begin the process.

The new Internet Links and the Internet Updates are seamlessly integrated into your 1998 Canadian and World 
Encyclopedia. 

Note: You must be connected to the internet to use this feature!
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A reference work is often out-of-date as soon as it is published. If you are connected to the Internet you can now 
update your encyclopedia monthly. Every month, The 1998 Canadian & World Encyclopedia provides its users 
with new articles from recent issues of Maclean’s magazine.

To Update Your Internet Links
1 From the File Menu, choose Get Internet Updates
2 If your Internet connection is currently open, the process will begin immediately. If you are not currently 

connected to your provider, the updater will automatically connect you and then begin the process.

The Internet Updates are seamlessly integrated into your 1998 Canadian and World Encyclopedia. They will 
appear on your Contents List and you can search them with SmartSearch and Boolean Search.

Note: You must be connected to the internet to use this feature!
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Use Bookmarks to keep track of lists of items for future reference. The 1998 Canadian & World Encyclopedia 
allows you to create numerous Bookmark Lists, to add or delete items and to preview and print your lists.

To Create a Bookmark List
1 Click on the Bookmark Button on the Toolbar.
2 In the Bookmark Window, click on the New Folder Button.
3 In the Create New Folder dialog box, type the name of the folder and click OK.

To Add an Item to a Bookmark List
1 From the File Menu, choose Get Internet Updates
2 Display the encyclopedia article, dictionary entry, internet link or multimedia item and select “Add” from the 

Bookmark Menu.
3 Select the folder in which you wish to store the item and click OK.

To Print a Bookmark List
1  Click the Bookmark Button to open the Bookmark Window.
2  Click the Print Button. (You can preview the printed list by clicking the Print Preview Button.

 Click here to view the Bookmark Window.
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To Print an Article or Dictionary Entry

 Display the encyclopedia article or dictionary entry that you want to print. Choose Print Article from the File Menu 
in Encyclopedia Mode or Print Entry from the File Menu in Dictionary Mode.

To Save an Article or Dictionary Entry

 Choose Save Article from the File Menu in Encyclopedia Mode or Save Entry from the File Menu in Dictionary 
Mode. If you have selected text, Save will offer the option of saving the whole article (or definition) or of saving the 
selected text.

To print a picture

Click the Print Button on the Toolbar in Media Mode. To print a frame from a video clip, pause the video with the 
Pause Button and click the Print Button. Printing pictures can be slow!

To copy text

Select the text with the mouse pointer held down

Choose Copy from the Edit Menu, or

Use the Windows or Macintosh keyboard commands
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Encyclopedia Mode: Definition
Encyclopedia Mode provides all the functions related to the finding and display of encyclopedia articles. Navigate to 
the Encyclopedia Mode by clicking the Encyclopedia Tab or by choosing Encyclopedia from the Navigation Menu. 

 Click here for more detailed information on the Encyclopedia Screen.



Dictionary Mode: Definition
Dictionary Mode provides all the functions related to the finding and display of dictionary entries. Navigate to the 
Dictionary Mode by clicking the Dictionary Tab or by choosing Dictionary from the Navigation Menu. 

 Click here for more detailed information on the Dictionary Screen.



Media Mode: Definition
Media Mode provides all the functions related to the finding and display of multimedia items. Navigate to the Media 
Mode by clicking the Media Tab or by choosing Media from the Navigation Menu. 

 Click here for more detailed information on the Media Screen.



Timeline Mode: Definition
Timeline Mode provides all the functions related to the finding and display of Timeline Events. Navigate to the 
Timeline Mode by clicking the Timeline Tab or by choosing Timeline from the Navigation Menu. 

 Click here for more detailed information on the Timeline Screen.



Quiz Mode: Definition
Quiz Mode provides all the functions related to the answering of the Canadiana Quiz. Navigate to the Quiz Mode by
clicking the Quiz Tab or by choosing Quiz from the Navigation Menu. 

 Click here for more detailed information on the Quiz Screen.



Searching the Encyclopedia Texts

The 1998 Canadian & World Encyclopedia provides the user with several powerful tools for searching the text of 
the encyclopedias. 

The text search procedures are activated by two buttons on the Toolbar.

1      Boolean Search
Use Boolean search to perform simple word searches or traditional Boolean searches. Boolean Search also 
provides more advanced features and spell checking.

 Click here for more detailed instructions on Boolean Search.

2      SmartSearch
Use SmartSearch to perform more general searches. While Boolean Search is appropriate for specific searches 
related to known names and terms, SmartSearch is designed to search for concepts, ideas and the relationships 
between words. 

 Click here for more detailed instructions on SmartSearch.



SmartSearch

Use SmartSearch for broader, more suggestive searches of the entire text of the disk, beyond simple requests for 
a term, name or place. 

What do you want to do?
 Use SmartSearch to Find Single Words.
 Use SmartSearch to Find Phrases.
 Learn more about SmartSearch Results.

 Click here for the SmartSearch Tutorial.



Using SmartSearch to Find Single Words

1    Click the SmartSearch Button on the Toolbar 

2    Type your word in the entry box and click the Begin Search button or Press Enter.

 Click here for help with the SmartSearch Window.

Note: Searching for a single word in SmartSearch gives you a results list that differs from such a search 
in Boolean Search. The results are not listed in alphabetical order but in the order that reflects the 
frequency or weight of your term.



Using SmartSearch to Find Phrases

1      Type a phrase referring to differing aspects of your query. 
The phrase may be in the form of a question, such as "Why do leaves turn colour in autumn?" or "Who 
invented the G suit?" The latter turns up the inventor Wilbur Franks first in the list and a picture of Franks 
and his suit.

 Click here for help with the SmartSearch Window.



SmartSearch Results

1      SmartSearch provides a results list in which terms of a phrase or group of words have been weighted 
according to various criteria, such as frequency, proximity and related terms.
2      The titles in the Results list are ranked in an order reflecting the likelihood that the articles answer the query. 

Thus if you type the query "Who was Yonge Street named for?" the entry Toronto appears near the top of 
the list. 

3      When you preview the articles in the SmartSearch results list (by double clicking the article title in the Results 
List), the viewer takes you automatically to the part of the article that is most likely to satisfy your query.
4      SmartSearch results lists include relevant multimedia items, as the example below includes a photographs of 
a raven as well as encyclopedia and dictionary items.

 Click here for help with the SmartSearch Results Window.

Note: Because few questions have simple or obvious answers, beyond simple questions of fact, the list 
will not always be ordered in a predictable manner. The purpose of SmartSearch is to find and 
suggest relationships that may not have occurred to the user as well as the kind of specific results 
provided by Boolean Search.



Tuner

The Tuner adds additional power and flexibility to searches of the encyclopedia text. In SmartSearch, click the 
Tuner Button to open the Tuner.

1 For each word in your search, use the mouse to move the slider to the right (+ to assign greater importance) 
or the left (- less importance).

2    Click the Begin Search Button to proceed. 



Spelling Check

Spell check is available in Boolean Search and in SmartSearch.

To check the spelling of your search terms in the Search Window:

1      In the Boolean Search or SmartSearch window, toggle the Spelling Button to read "Spelling On."    (Toggle to 
"Spelling Off" to turn off this feature.)
2      If one of the terms that you have entered in the search box is not found, Boolean Search or SmartSearch offer
a list of alternative spellings. 

For example, you may be looking for the article on the governor of New France and type Vaudriel. 
Boolean Search or SmartSearch suggests Vaudreuil. 

3      Choose Change in order to change the search term to the term selected in the list box. 
Choose Ignore to proceed with the search without changing the spelling of the current term, Ignore All to proceed 
without changing the spelling of any of the search terms, and choose Cancel to stop the search altogether.



Not
Use the "NOT" operator (!) to restrict your search of multiple terms by excluding certain items. 

For example, you may want to find all the references to sport (437 results in The 1998 Canadian & World 
Encyclopedia), but not hockey or baseball (391 results). To perform this search, type sports in the first text 
box, click the NOT button after the term, type the word hockey, and then repeat the process for baseball. 
Your search would look like the following in the advanced window:
sports NOT hockey NOT baseball 

Proceed with the search to see all the records which contain the word sports but do not contain the words hockey 
or baseball. 



Or
Use the "OR" operator (|)to find articles that contain any one or any combination of your terms; hence the search 
fish OR birds OR mammals turns up 2741 results in The Canadian Encyclopedia, when such a search using AND 
gives only 51 results.

 Click the Or button after each of your terms or type the word OR (in capital letters) after each term in the 
advanced window.

Use OR to search for variations of spelling or for plurals of the same word; for example, Parliament OR 
parliaments OR Parliamentary, or for words and their abbreviations. For example, you might look for 
Ontario (2512 results) OR Ont OR Ont. (3656 results).



And
Use the AND operator (&) to find only those articles that contain every word in your search. 

For example, if you enter the words fish AND birds AND mammals, you will turn up every article that contains all 
these words together in the same article. An article with just the word "fish" would not satisfy this search. (You can 
use the ampersand symbol & in place of the word AND in the advanced window.)



Boolean
A Boolean Search is a complex search using operators such as "AND" (&), "OR" (|), "NOT" (!) and “NEAR” (~). It 
is named for the algebraic system developed by the English mathematician George Boole. 

Boolean operators allow you to define relationships between the terms in your search.



Near
Use the NEAR operator (~) to find only those articles in which your search terms appear within a few words of one
another. 

For example, if you search for the words Canada AND council, you will turn up 932 results when searching 
The Canadian Encyclopedia. If you search for Canada NEAR council the results are narrowed to 333, 
increasing the likelihood that you are finding the organization Canada Council.



Accents

When searching for terms with accented characters, such as Montréal, you must enter the accented character 
using the ASCII codes, or Select the term (see Selecting Text) in an article and click the Related Button.

The following are some common characters in Windows:

NOTE: When typing the number you must use the Number Pad.



Combined Searches Using Boolean Operators

You can perform complex searches which combine the AND, OR and NOT operators, for example the following: 
bank or club not Canada

The results will include every article that contains either the word bank or the word club but not the word Canada.

Note: If you use multiple search operators, they are processed in order of precedence and then from first 
to last. AND and NOT have equal precedence over OR.



Boolean Search

Activate Boolean Search by clicking the Boolean Search Button on the Toolbar. Boolean Searches utilize Boolean 
operators (AND, OR, NOT, NEAR) to define the relationships between your search terms.

What do you want to do?
 Use Boolean Search for Simple Word Searches 
 Use Boolean Search for More Complex Searches 
 Use Advanced Boolean Search 



Boolean Simple Word Searches

To search for all entries in the encyclopedias that contain a single word:
1     Enter the word you are looking for in the Search entry box.
2     Click the Begin Search Button on the top right of the search window or press Enter. If no articles satisfy the 
search, you are informed that there are no matching articles. If several articles satisfy your search, they will be 
listed in alphabetical order.

Note: Click the Canadian Encyclopedia Source Filter in the results list to display results only from The 
Canadian Encyclopedia. Choose the Canadian & Columbia Filter to search the Columbia 
Encyclopedia as well.



Boolean Complex Searches

Search allows you to expand your search of the encyclopedia text by defining a relationship between multiple 
terms (so-called Boolean searches).

Use Boolean operators (AND, OR, NOT and NEAR) to produce results that include all the keywords in your topic 
or to a selective group of keywords.

And
1      Use the AND operator to find only those encyclopedia entries that contain all your terms. 

Type the first term, choose AND from the Boolean Drop Down List and then enter your next term in the 
second search box. You can enter up to 5 terms.

2 Click the Begin Search Button. The results will be listed in alphabetical order.
 Click here for an illustration of AND

Or
1      Use OR operator to find all the articles that include any one or more of your terms. 

Type the first term, choose OR from the Boolean Drop Down List and then enter your next term in the 
second search box. You can enter up to 5 terms.

3 Click the Begin Search Button. The results will be listed in alphabetical order.
 Click here for an illustration of OR

Not
1     Use the NOT operator to narrow your search by excluding terms. 

Type the first term, choose NOT from the Boolean Drop Down List and then enter your next term in the 
second search box. You can enter up to 5 terms.

2     Click the Begin Search Button. The results will be listed in alphabetical order.

Near
1     Use the NEAR operator to narrow your search to only those articles in which your terms appear close (i.e. 8 
words or less) to one another. This search is useful for finding personal names.

Type the first term, choose NEAR from the Boolean Drop Down List and then enter your next term in the 
second search box. You can enter up to 5 terms.

2     Click the Begin Search Button. The results will be listed in alphabetical order.

Note: In Advanced search you can use the following symbols for Boolean operators
AND &
OR |
NOT !
NEAR ~



Boolean Advanced Searches

Use the Advanced Boolean Search Window to enter your own search string. 
 Be sure that you type the Boolean operators in capital letters!

 Click on the above graphic for descriptions of items on the Boolean Advanced Screen.

Note: In Advanced search and in dictionary searches you can use the following symbols for Boolean 
operators

AND &
OR |
NOT !
NEAR ~



And Illustration
In this example the results list will include only those articles that contain ALL the terms.



Or Illustration
In this illustration, the search results will include articles that include any one of the terms in search.



Subject Index

Use the Subject Index to find articles in the encyclopedias that are related to one another under common subject 
headings.

Many of the main subject headings lead to as many as 5 or 6 levels. Example

To Find a Subject Heading
1      Click the Subject Button on the Toolbar in Encyclopedia Mode (the only mode in which the encyclopedia 
subject tree is available).

2      Choose whether you wish to Browse the subject tree or to Search the subject list by clicking the appropriate 
button.

 
to Browse the list

 
to Search the list

 Click here for step by step instructions on How to Browse the Subject List

 Click here for step by step instructions on How to Search the Subject List

 Click here to see the Search Subjects Screen.

Note: You can display the articles in the same subject category as the current article by choosing Subject 
Links from the Related Menu.



How to Browse the Subject List

Description: Browse Subjects moves through the structured subject tree
1     Click the Subject Button in Encyclopedia Mode

        
2      Click the Browse Subjects Button
        

3      Scroll down to a subject of interest, e.g., Architecture
4      Click the right-pointing arrow  to display the next level
5     Continue clicking until you reach a subject that interests you
6      Click the down-pointing arrow  to collapse a list

6      Choose an article from the Titles list

 Click here to see the Browse Subject Screen.



How to Search the Subject List

Description: Search Subjects searches all subject headings, regardless of their place in the subject tree.
1      Click the Subjects Button
        

2      Click the Search Subjects Button
        

3      Begin to type the subject name into the dialog box
4     As the list moves through the alphabet, choose a subject
5      Choose an article from the Titles list

 Click here to see the Search Subjects Screen.



Example Subject Tree



Browse Subject Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.



Search Subject Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.



Dictionary

The 1998 Canadian & World Encyclopedia contains two complete dictionaries, the English only Gage Canadian 
Dictionary and a full-featured bilingual dictionary which translates from French to English and English to French as
well as conjugates French verbs. A thesaurus provides English synonyms.
 Click Here to view the Dictionary Screen 

There are several ways to open the dictionaries

Click the Dictionary Tab to navigate to Dictionary Mode. 

        

Choose Dictionary from the Navigation Menu.

 Double click on a word in the text of any encyclopedia, timeline or dictionary entry. A search for your word is 
begun automatically.

Note: The auto-search function of the dictionary defaults to the last dictionary used in the current session;
i.e., if you last used the French-English dictionary and double click a word in the encyclopedia, the 
word will be looked up in the French-English dictionary.

Key Related Topics
 Finding a Definition in the Dictionary
 Searching for Terms in the Dictionary
 Boolean Searches in the Dictionary
 Anagrams
 Using Wildcards in the Dictionary
 Thesaurus
 French-English Dictionary



Finding a Definition in the Dictionary

To find a definition in the Dictionary
1 Open the Dictionary by clicking the Dictionary Tab on the lower left of any screen.
2 Using the buttons on the upper left, 

 Click the Gage Button to look up a word in English

 Click the French-English Button to find an English translation of a French word

 Click the English-French Button to find a French translation of an English word

 Click Thesaurus to find synonyms for an English word

Note: To activate the English dictionary and the Thesaurus at the same time, click the Split Button.

Enter the term in the Search Word or Expression entry box of the Dictionary Window (or double click a word in the 
text of an article).

3 Press Enter or click the Definition Button (or Translation Button if you are using the bilingual dictionary) to find 
the definition.

4 If no word is found, a window prompts you to choose an alternative spelling (if one is available) from the 
Spelling Alternatives List.

5 Choose one of the alternative spellings and click the Definition (or Translation) button.

 Click here for help with entering accents in your search. 
 Click here for pop-up help with the dictionary screen.



Searching for Terms in the Dictionary

While the Definition Button looks for a separate definition for your term, Boolean or SmartSearch find that term no 
matter where it appears in the dictionary.

To search for a term in the entire dictionary
1 Type a term, for example rodent, into the Boolean Search box or the SmartSearch box. Click the Begin 

Search Button.
2 Click the Gage Dictionary Source Filter to display dictionary entries only.
3 The Search Results screen lists the entry Rodent along with all other entries that include the word rodent.
4 Move to another definition by double clicking a word in the Results list, for example, muskrat.



Boolean Searches in the Dictionary

Use Boolean operators to broaden or to narrow your searches of The Gage Canadian Dictionary or the bilingual 
dictionary. Click the Boolean Search Button on the Toolbar to activate Boolean Search.

The And Operator
Use the AND operator to find only those dictionary entries that contain all your terms.

1. Type the first term, then choose AND from the dropdown list of Boolean operators (it must be in capital letters if 
you are using Advanced Search) and then add your next term; for example, woodsman AND fur.

2. Click the Begin Search Button to generate a list.
3. Click the Gage Dictionary Filter to display only entries from the dictionary, choose a word from the Results list 

and double click.
4.
Note: Use the AND search to find words where you know that a term exists and know other words that 

describe it. In the above example, the word coureur de bois was found.

The OR Operator
Look for entries containing any of your terms using the OR operator; for example type fish OR fowl. Click the 
Search button. (Generating a list including bluefish and chicken.)

Note: Use the OR search to find words and variations of words. For example, rodent OR rodents

The NOT Operator
Narrow your search using the NOT operator, for example, type forage NOT hay. Click the Search Button. 
(Achieving a list including barley and soybean.)



Anagrams

Anagrams are words formed by reordering the letters of another word. A single word or phrase may yield many 
anagrams or none. To find anagrams

1 Open the Dictionary by clicking the Dictionary Tab in any screen.
2 Click the Gage Dictionary Button and enter a word or phrase into the search box.
3 Set the Options for the minimum number of letters required for an anagram in the Options Menu. 
4 (For example, enter a length of 8 for the word broadcasting and get over 20 anagrams. Set it to 9 and get only

9 anagrams.)
5 Click the Anagram Button.



Using Wildcards in the Dictionary

Wildcard characters can be used in dictionary searches to represent unknown letters or sequences of letters. 
There are two wildcard characters: ? and *.

1 Use a question mark (?) to stand for a single unknown character. For example, typing f?rmer gives the results 
farmer, firmer and former. 

2 Use an asterisk (*) to stand for an indefinite number of characters. For example, type hon*r to find all words 
beginning with "hon" and ending in "r," such as honeymooner and honour, or voyag*r to find the word 
voyageur.

3 Enter your word or phrase, including wildcards, in the Search box and then click the Wildcard Button. (The 
button lights up only when you enter a wildcard.)

4 Choose a word from the Wildcard list by double clicking the word or by highlighting the word and pressing 
Enter.



Thesaurus

The Thesaurus is located in the dictionary window and is activated in the same manner as the Dictionary, by 
double clicking a word in the text of an article or by clicking the Thesaurus Button, entering a word or phrase in the
Search entry box and clicking the Synonym Button.

Definitions appear in the pane to the right, synonyms in the lower Synonym pane. Double click a word in the 
synonym list to get a definition of that word and a new list of synonyms.

Note: To activate BOTH the Thesaurus and the English dictionary, choose the Split Button.



The French-English Dictionary

Use the bilingual dictionary to translate words to and from English and French

1      Translation from English to French

To translate a word from English to French, click the English-French Button

Type in your term and Click the Translation Button. To find all the places the word appears in French entries in the 
dictionary, click the Search Button.

2      Translation from French to English

To translate a word from French to English, click the French-English Button

Type in your term and Click the Translation Button. To find all the places the word appears in English entries in the 
dictionary, click the Search Button.

Note: You can enter French accents into the dictionary search box by using the Character Map (in 
Accessories in Windows), or by using the codes outlined the Accents Table.

3      Conjugation of French Verbs

To conjugate a French verb, enter the verb into the search box and click the Conjugate Button. Choose the verb 
tense from the Tenses list.



Saving and Copying Definitions

Saving Definitions

To save a definition from the dictionary, choose Save Entry (Ctl + S) from the Edit menu in the Dictionary Window. 
Name the entry and click OK.

Copying Definitions

To copy a definition from the dictionary, choose Copy Entry (Ctl + C) from the Edit menu in the Dictionary Window. 
To insert the definition into a note or document in another program, press SHIFT+INSERT (Windows) or 
Command+V (Macintosh).



Spelling Alternatives List



Optimizing Multimedia Performance

In order to get the best performance of the multimedia elements of the encyclopedia, you should ensure that your 
hardware and software have been set up properly.

 Audio
The audio selections work best with a 16-bit sound card. Not all of the sounds will play on an 8-bit sound card. If 
you have a sound card installed but still cannot hear the sounds, check to make sure that the proper drivers are 
installed. Consult your Windows or Macintosh manual for instructions on installing drivers.

 Video and Animation 
Videos and animations will work smoothly only if QuickTime has been correctly installed during installation. The 
speed and smoothness of the video depend on the speed of your processor, the quality of your video card and the 
amount of RAM available.

Note: The 1998 Canadian & World Encyclopedia utilizes QuickTime 2.1.2. If these files are overwritten by 
an earlier version of QuickTime, the videos and QuickTime VRs in this program may not play.

 Pictures
You must run your computer with at least 256 colours for the proper display of the pictures. Make sure that the 
latest video software drivers are installed on your computer. Most manufacturers provide updated drivers for their 
video cards. The pictures will show on a 16-colour display but will be of poor quality.



Viewing and Navigating the Multimedia

Where multimedia items in The 1998 Canadian & World Encyclopedia appear 
1 As titles in the search results from SmartSearch, Boolean Search or from searches in the Multimedia Browser 

(see Searching the Multimedia).
2 As titles in the Contents List.
3 As Thumbnails in the text of articles.
4 As Thumbnails in Timeline Events.

How multimedia items are viewed
1 By double clicking on a thumbnail.
2 By double clicking on a multimedia title in the Contents List or on the Multimedia Subject Browser or in a 

search list.

 Pictures
To view a picture, double click on its title in a results list or double click a thumbnail displayed in the text.

 Sounds
To play a sound, double click on its title in a results list or double click a thumbnail displayed in the text. Then click 
the Sound Button to listen to the sound.

 Videos or Animations
To play a video or animation, double click the title with the mouse and then click the Play Button on the Video 
Player. 

 QuickTime VR
QuickTime VR are special pictures that enable a viewer to move through a panorama and to zoom in or zoom out 
of a scene.

 Hypergraphics
Hypergraphics allow the user to click on a "hot" spot on a picture and zoom to a related subject or to a detail of the
current subject.

    Click here for more information on the Media Subject Browser.
    Click here for more information on the Video Player.
    Click here for more information on the main Media Screen.



Going to an Article from Multimedia
Choose Go To Article from the Multimedia Menu in Media Mode. If more than one article is associated with a 
multimedia item, a dialog box offers a list from which to choose.



Slide Show

Starting the Slide Show
Click the Slideshow Button in Media Mode to run a slide show of pictures from the encyclopedia. 
Note: Set the delay between pictures in Preferences 

Stopping the Slide Show
1 Click the Stop Slide Show Button to quit the slide show and return to the Browser. 
2 To go to the article associated with a picture, choose Go to Article from the Multimedia Menu.

Note: The pictures in the slide show display in the order that they appear in the media index. The filters 
and subject categories still work in slide show. For example, if you choose the media subject 
Arts/Painting, the slide show will only include items in the painting category. If you choose the 
subject All and the filter Graphs, slide show will show only graphs and no other media.



Viewing Multimedia from the Encyclopedia Window

All multimedia elements appear in the text of articles as thumbnails (if this option has been chosen in Preferences). 
When you pass the mouse pointer over the thumbnails, the pointer changes to indicate the type of media. In the 
example below, the pointer indicates that the item is a photograph.

When viewing an article with multimedia, double click the thumbnail to expand the picture or to launch the video 
player. 

Note: In the text of articles, sounds do not appear as separate multimedia items as they do on the 
Contents List or Multimedia Subject Browser. In articles, all sounds are associated with pictures. 
Bring up the picture and click the sound button.



Sound

All sounds in The 1998 Canadian & World Encyclopedia are associated with pictures. When a sound is associated
with a particular picture, the Sound Button on the Media Toolbar lights up.
Note: The audio selections work best with a 16-bit sound card. If you have a sound card installed but still 

cannot hear the sounds, check to make sure that the proper drivers are installed. Consult your 
Windows or Macintosh manual for instructions on installing drivers.

What do you want to do?
 Find Sounds in the Contents List
 Find Sounds in Articles
 Play a Sound



Finding Sounds in the Contents List

To find a sound on the Contents List, click the Contents Button to display a list of all the items in the encyclopedia.
1 If you are looking for a specific sound, such as Badger, type badger in the contents list and if your topic 

appears on the list, double click on the title (e.g., Badger).
2 If you are looking for a complete list of all sounds and all articles with sounds on the disk, click the Sound 

Media Filter while all the Source Filters are active.
3 If you are looking for a list of just the sounds themselves, first click the Media Source Filter and then click the 

Sound Media Filter.
4 To find sounds in a particular subject area, choose the subject from the subject list in the Media Subject 

Browser (eg., Birds) and select the Sound Media Filter.



Finding Sounds in the Articles

In the text of articles, sounds do not appear as separate multimedia items as they do on the Contents List or on 
the Media Subject Browser. In articles, all sounds are associated with pictures. When you pass the mouse over a 
thumbnail that is associated with a sound, the pointer changes to a picture and sound icon. 

Bring up the picture and click the Sound Button on the Media Toolbar.



Playing Sounds

To play a sound, double click on its title in the Title list or on a picture thumbnail in an article (all sounds are 
associated with pictures). Click the Play Sound Button.

Note: The audio selections work best with a 16-bit sound card. If you have a sound card installed but still 
cannot hear the sounds, check to make sure that the proper drivers are installed. Consult your 
Windows or Macintosh manual for instructions on installing drivers.



Searching the Multimedia

The 1998 Canadian & World Encyclopedia contains over 4300 multimedia items distributed in over 7000 locations.
These items are categorized by type (video, sound, photo etc) and by subject (birds, trees, paintings, etc). 

 Click here to see how to find multimedia using the Contents List.
 Click here to see how to find multimedia using the Media Subject Browser

Note: You can also search for multimedia titles using regular Boolean Search and SmartSearch 
procedures. The multimedia that satisfies the search will appear in the results list, marked by a 
multimedia icon.

Key Related Topics
    Optimizing Multimedia Performance
    Viewing and Navigating Multimedia
    Slideshow
    Video
    Sound



Finding Multimedia Using the Contents List

1 Click the Contents Button to display a list of all items on the disk.
2 If you know the title of the media item you are looking for, type it into the title area of the Contents dialog box 

and the list will move alphabetically to the item.
3 To find media associated with different sources, choose the appropriate Source Filters.
4 To look at titles of media items only (not including article titles), choose the Media Source Filter.
5 To display titles of particular types of media (e.g., pictures, videos), click the appropriate Media Filters.



Finding Multimedia Using the Media Subject Browser

1 Click the Media Tab to enter Media Mode.
2 Click the Media Subject Button
3 Open the Media Subject Tree by clicking the Open Subjects Button.
4 Choose the appropriate subject and view the list.
5 To restrict the list to particular types of media (e.g., graphs, sounds) use the appropriate Media Filters.



Hot Spots

Hot spots, or hypergraphics, allow the user to click on a "hot" spot on a picture and zoom to a related subject or to 
a detail of the current subject, much as Cross References allow the linking of articles.



How to Use Hot Spots

 Find a Hypergraphic (a map or picture containing hot spots) by using the Hot Spot Filter on the Contents List.

 Move the cursor over the graphic until the colour reverses and the cursor turns to a pointing hand, as in the example 
below:

 Click on the hot spot to display the new picture.

Legends
1 Click the Legend Button to display a list of all hot spots on the graphic. NB: In Windows 95 and 3.1 only, click 

the hypergraphic with the right mouse button to bring up the list of hot spots.
2 As you move your cursor over the legend, the colour reverses on the graphic to show the location of the hot 

spot.
3 Click a legend item to display the hot spot picture.

 Click here to view an example of a Legend.



How to Use QuickTime VR

QuickTime VR are panoramas composed of a number of images, each one shown from a different angle. Moving 
around in this panorama is like moving around in the scene itself. In The 1998 Canadian & World Encyclopedia 
Quicktime VRs are marked with the following icon:

Double click on the title as you would a video or picture. 

Move around using the following controls.

How To Windows Macintosh
Look around Click and drag the mouse Click and drag the mouse
Zoom in Press Shift Press Option
Zoom out Press Control Press Control
Jump to another 
location

Move the pointer to a jump spot  
and click

Move the pointer to a jump spot  
and click



Timeline Introduction

To enter the Timeline, click the Timeline Tab    or choose Timeline from the Navigation Menu. 

The events in Timeline are arranged in several different subjects. Click on the appropriate subject for a description 
of each:

Categories

Canadian Firsts

On This Day

Periods

Search by Date

Year in Review

 Click here for a description of the Timeline Screen.



Timeline Categories

Use categories in the Timeline to view Canadian events grouped under categories, such as Education or Science.

To view events by categories
1 Click the Category Button on the Toolbar in Timeline Mode.
2 Choose a category by moving the cursor over the main Category Screen or by choosing a category from the 

Category drop-down menu.
3 Click on a category to display a list of events.
4 Scroll through the events using the scroll bar.
5 View events in the Event Screen.

Note: Scroll the main Category Screen by pointing the cursor off the right edge of the screen to move 
right or off the right edge of the screen to move right.

To return to the main Category Screen

 Click Select a Category and pick All from the drop-down list or click the Show All Button.

Related

Canadian Firsts

On This Day

Periods

Search by Date

Year in Review

 Click here for a description of the Timeline Screen.



Timeline Periods

To view events by periods
1 Click the Period Button on the Toolbar in Timeline Mode.
2 Choose a period by moving the cursor over the main Category Screen.
3 Click on a period to display a list of events.
4 Scroll through the events using the scroll bar.
5 View events in the Event Screen.

Note: Scroll the main Period Screen by pointing the cursor off the right edge of the screen to move right 
or off the right edge of the screen to move right.

To return to the main Period Screen

 Click Choose a Period and pick All from the drop-down list.

Related

Categories

Canadian Firsts

On This Day

Search by Date

Year in Review

 Click here for a description of the Timeline Screen.



Timeline Search by Date

To search for events by date
1 Click on the Search by Date Button on the Toolbar in Timeline Mode.
2 Choose the time frame by entering the year and month for both the beginning and end.
3 Type in the years and choose the months from the Search Drop-down Menu.
4 Click the Begin Search Button.
5 View events in the Event Screen.

Related

Categories

Canadian Firsts

On This Day

Periods

Year in Review

 Click here for a description of the Timeline Screen.



Timeline Year in Review

To search the Maclean's Year in Review articles
1 Click on the Year in Review Button on the Toolbar in Timeline Mode.
2 Choose the time frame by choosing a year and month from the main Year in Review screen, OR
3 Choose year and month from the drop-down menu.
4 View events in the Event Screen.

Related

Categories

Canadian Firsts

On This Day

Periods

Search by Date

 Click here for a description of the Timeline Screen.



Timeline Canadian Firsts

To search the list of Canadian Firsts
1 Click on the Canadian Firsts Button on the Toolbar in Timeline Mode.
2 Double click on an event.
3 Scroll down the list using the scroll bar.
4 View events in the Event Screen.

Related

Categories

On This Day

Periods

Search by Date

Year in Review

 Click here for a description of the Timeline Screen.



Timeline On This Day

To find events that happened on a specific day in history
1 Click on the On This Day Button on the Toolbar in Timeline Mode.
2 Choose the year and month from the Month and Day Drop-down Menus.
3 Click the Begin Search Button.
4 View events in the Event Screen.

Related

Categories

Canadian Firsts

Periods

Search by Date

Year in Review

 Click here for a description of the Timeline Screen.



Choose a Category



Choose a Period



Event Screen
The event screen in Timeline displays an event according to the period, category or dates chosen. Click the 
thumbnail to display the graphic at full size.



Main Period Screen
The Main Period Screen shows the periods of Canadian history. Click on a period to display the events of that era.

Note: Scroll the main Screen by pointing the cursor off the right edge of the screen to move right or off the
left edge of the screen to move left.



Quiz

The Canadiana Quiz will test your knowledge of Canada. It contains questions in both English and French, and 
can be taken randomly or sequentially or by category.

Starting the Quiz
 Launch the encyclopedia quiz by clicking the Quiz Tab or by choosing Quiz from the Navigation Menu.

Note: The Quiz is available in both English and French. Choose French or English on the Question Menu 
in the Quiz Screen. The questions are identical.

What do you want to do?
 Answer Questions in the Quiz 
 Get a clue or find information related to the current question 
 Choose a category of questions 
 Switch languages in the Quiz 
 Solve the puzzle 
 View the Quiz Screen



How to Answer a Question in the Quiz

1 Answer a question by choosing the appropriate letter button below the question or next to an illustration. 
2 If the answer is correct, it is registered on the scoreboard, a piece of the puzzle appears and a new question 

appears automatically. 
3 Click the New Question Button to display another question without answering the current one.

 Click here to view the Quiz Screen.



Getting a Clue in the Quiz

1 If you do not know the answer or want to find out more about the subject of the question, click the Clue Button
on the Toolbar to go to a relevant encyclopedia article. 

2 Click the Quiz Tab to return to the question.

 Click here to view the Quiz Screen.



Choosing a Category in the Quiz

1 To choose a category in the Quiz, click the Categories Menu in Quiz Mode.
2 Click the category.
3 Click another category, up to as many as you wish to include.
4 Click All to include all categories.

 Click here to view the Quiz Screen.



Switching Languages in the Quiz

1 To change languages in the Quiz, Click the Question Menu in Quiz Mode.
2 Select the language, French or English.
3 The same question is displayed as you switch languages and the score is kept.

 Click here to view the Quiz Screen.



Solving the Puzzle in the Quiz

1 When you have completed enough of the quiz to have all the pieces of the puzzle appear, you can try to solve
the puzzle by moving the pieces with the mouse. The puzzle is similar to the small games with push tablets 
familiar to most children. 

2 Click the Hint Button to move one piece or the Solve Button to solve the entire puzzle. 
3 The Jumble Button rescrambles the puzzle.

Puzzle Options
The Puzzle menu allows you to turn the sound on or off, remove the numbers from the puzzle pieces or to insert a 
new picture as the puzzle.

 Click here to view the Quiz Screen.



Buttons, Tabs and Filters

Advanced Button 
Anagram Button 
Apply Button 

Back Button 
Basic Button 
Begin Search Button 
Bookmark Button 
Bookmark Help Button 
Bookmark Print Button 
Boolean Advanced Help Button 
Boolean Search Button 
Browse Subjects Button 

Canadian Source Filter 
Canadian/Columbia Source Filter 
Cancel Button 
Caption Button 
Category Button 
Change Button 
Check Box Button 
Clear Entry Button 
Close Button 
Close Caption Button 
Clue Button 
Conjugate Button 
Connect Button 
Contents Button 
Copy URL Button 

Definition Button 
Delete Folder Button 
Dictionary Tab 

Encyclopedia Tab 
English French Button 
Firsts Button 
French to English Button 

Gage Dictionary Button 
Gage Dictionary/Thesaurus 
Gage Dictionary Source Filter 
Graph Media Filter 

Help Button 
Hint Button 
Hot Spots Media Filter 



Ignore All Button 
Ignore Button 
Internet Source Filter 
Jumble Button 
Legend Button 

Maclean's Source Filter 
Map Media Filter 
Media Tab 
Multimedia Source Filter 

New Folder Button 
New Question Button 
Next Button 

OK Button 
On This Day Button 
Open Button 
Outline Button 

Period Button 
Picture Media Filter 
Print Button 

QuickSearch    Button 
Quiz Tab 

Random Button 
Related Button 
Rename Folder Button 
Review Button 
Rewind Button 

Save Button 
Search Button 
Search by Date Button 

Search Subject Button 
Show All Button 
Slideshow button 
SmartSearch Button 
Sound Media Filter 
Solve Button 
Sound Button 
Spelling On Button 
Stop Button 
Stop Sound Button 
Subject Button 
Subject Tree Close Button 
Subject Tree Open Button 



Synonym Button 

Table Media Filter 
Thesaurus Button 
Timeline Source Filter 
Timeline Tab 
Translation Button 
Tuner Button 

Video/Animation Media Filter 
VR Button 
Wildcard Button 
Zoom In Button 
Zoom Out Button 

 See Also Button States 



SmartSearch Illustration



Button States

The buttons on The 1998 Canadian & World Encyclopedia appear in different states according to the status of the 
function that they represent. There are four main states:

Disabled
A button is disabled (grayed out) when its function is not available, as in the example below, which appears when 
an encyclopedia article does not have an outline:

Enabled
A button is enabled (coloured) when its function is available, as in the example below, which appears when an 
encyclopedia article has an outline:

Roll Over
A button changes colour when it is enabled and the mouse pointer rolls over it, as in the example below, which 
appears when the mouse rolls over an enabled Outline Button:

Selected
A button changes to include a    fine black line to show that its function is selected, as in the example below, which 
shows that the outline feature has been chosen:



Toolbar

A Toolbar is a series of buttons that appears across the top of the screen in The 1998 Canadian & World 
Encyclopedia. These buttons vary according to the mode (i.e., there are different buttons in Timeline Mode than 
appear in Encyclopedia Mode). In addition, the buttons within a mode change according to the features available 
to the object that you are viewing.

 Example1: Toolbar in Encyclopedia Mode
 Example 2: Toolbar in Media Mode
 Example 3: Media Toolbar with Hotspot Feature
 Example 4: Media Toolbar with VR



Media Filters

Use the media filters to expand or restrict the Contents List. When you click the Contents Button, the entire 
contents of the disk are displayed in the list. Use the media filters to display some or all of the media on the disk.

 Click on the graphic above to identify the media filters.

Click a filter to view the items from that media. For example, click on the Video Filter to view the list of all the videos 
and animations on the disk. The state of the media filter turns to on. 

To view the items of more than one type of media, click the filters for those media. In the following example, the filters 
for video, maps and sounds are on, displaying only those media in the Contents List.

Note: The Media Filters control both the list of media items AND a list of encyclopedia entries that contain
media. To view only the list of media, click the Media Source Filter.

Combining Filters
To see, for example, all the pictures in Timeline, click the Timeline Source Filter and the Picture Filter as in the 
example below.

 See Also Source Filters 



Source Filters

Use the source filters to expand or restrict the Contents List. When you click the Contents Button, the entire 
contents of the disk are displayed in the list. Use the filters to display some or all of the contents.

 Click on the graphic above to identify the filters.

Click a filter to view the items from that source. For example, click on the Canadian Encyclopedia Filter to view the list
of entries from The Canadian Encyclopedia. The state of the source filter turns to on. 

To view the items from more than one source, click the filters for those sources. In the following example, the filters 
for The Canadian Encyclopedia, the Internet Links and the Timeline are on, displaying only the items from those three
sources.

Note: Because of contractual arrangements, you cannot view the titles from the Columbia Encyclopedia 
alone.

 See Also Media Filters 



Encyclopedia Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topics
 Contents
    Subjects
    SmartSearch
    Boolean Search
    Source Filters



Dictionary Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topics
    Dictionary
    Contents
    French English Dictionary
    Thesaurus



Media Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topics
    Media Filters
    Media Subject Browser
    Video Player
    Slideshow



Timeline Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topics
    Timeline
    Timeline Categories
    Timeline Periods
    Timeline On This Day
    Timeline Firsts
    Timeline Year in Review



Quiz Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topic
 Quiz 



Contents Title Box
The title box displays the current article title. Type the title of the item that you want to find. The list will move 
automatically through the alphabet.



Contents Title List
This is the area in which titles of the contents list are displayed. Icons to the left of the title denote the source or 
media type of the item.



Cross Reference

Cross References are pointers to other articles in the encyclopedia which contain information related to the current
article. They are directly linked to the articles of the same name.
 Click here for more information on Cross References.



Cross References

Cross references appear underlined, in capital letters and by default are coloured dark green. (You can change the
colour on the Preference dialog box.)

To activate a Cross Reference
1 Place the mouse pointer over the cross reference. The pointer turns to a large vertical arrow.
2 Click the reference once with the mouse.
3 You are transferred directly to the new article.
4 To return to the original article, click the Back Button.



Thumbnail
A thumbnail is a small graphical representation of a multimedia item located in the text of the encyclopedia. Double
click on the thumbnail to display the picture at its full size or to launch the video player.



Article Display Area
The text of an encyclopedia or Maclean’s article is displayed in this area. Click the Zoom Button to enlarge the 
area. Use Preferences to change the size and style of the display font.



Number of Items
This area of the screen shows the number of items in the Contents List according to the Source and Media Filters 
selected.



Article Title Display
This area shows the full title of the current entry. The source is denoted by the accompanying icon.



Article Subject Display
The subject to which the current article belongs is shown in this area.



Article Scroll Bar
Use the scroll bar to move up or down the current article.
 Click here for more information on how to use the Scroll Bar.



Scroll Bar

To move through the text using the scroll bar: 

Click on the solid scroll arrows  to move up or down one line at a time

Click on the open scroll arrows  to move up or down to the next match in your search terms

Drag the scroll box  up and down to a new position in the text



System Menu
The System menu is located in the extreme upper left of all the main screens. To drop the menu click the Maple 
Leaf logo.

The options presented on the menu are to Restore, Move, Size, or Minimize the Encyclopedia Window or 
to Close the program.



Contents

Contents provides a means for the user to have access to all the great resources of The 1998 Canadian & World 
Encyclopedia with the click of a single button. Clicking the Contents Button on the Toolbar displays a Contents 
List, with the titles of all the encyclopedia articles, Maclean’s articles, dictionary entries, internet links, updates, 
timeline events and multimedia objects on the disk.

 Click here for a description of the Contents List window.
 Click here for help on how to use the Source Filters on the Contents List.
 Click here for help on how to use the Media Filters on the Contents List.
 Click here for help on how to use QuickSearch on the Contents List.



Contents List

 Roll the mouse over the graphic and click for descriptions.

The Contents List contains a list of items according to the Source Filters and Media Filters currently selected. By 
default, all items on the disk are shown. Use the filters to narrow the list to show, for example, only dictionary entries.



QuickSearch

Use QuickSearch to search all the words in all the titles of the Contents List. 

To Use Quicksearch
1 Enter the term that you wish to find in the search box. (If you click Quicksearch when a title is showing, the 

results will only show titles with the same words. If no title matches, no list will appear.) You can search for 
more than one word in the Windows version only.

2 Click the Quicksearch Button 
3 Choose the item that you wish to view from the drop-down results list

 Click here to see a QuickSearch Example.



QuickSearch Example

If you type the word “information” into the Contents Title Box, you are taken automatically to the first item that 
begins with that word, the dictionary entry Information. If you click QuickSearch, you are presented with a list of all 
the articles containing your search term. Click on one of these titles to display the article. 

This procedure is very helpful in finding people with complex names or titles; for example, if you type the 
name Beaverbrook and then click QuickSearch, the Results screen shows the article Aitken, William 
Maxwell, 1st Baron Beaverbrook, among others. If you know a first name, for example Margaret, click 
QuickSearch will display a list of all the titles containing Margaret.

The following picture shows the results of a QuickSearch on the word “Alberta.”



Source Filters: Dictionary
In this case, only the Dictionary Filter is selected, showing only the dictionary entries in the Contents List.



Media Filters: Dictionary
In this case, none of the filters are selected since there are no media items associated with dictionary entries.



Puzzle
As you provide correct answers to quiz questions, a new piece of the puzzle appears. See Quiz for more 
information.



Quiz Categories Drop Down Menu
Click the menu to drop down a list of available categories. Choose All, one or a combination of categories.



Quiz Illustration
Illustrations sometimes form part of the questions or sometimes are just supplementary.



Quiz Answer Buttons
Click these buttons to choose your answer.



Quiz Scoreboard
The scoreboard keeps score for the current session.



Source Filters: Timeline
Click the Timeline Source Filter to display only Timeline events.

 See Source Filters for more information.



Media Filters: Timeline
Media filters operate in Timeline.

 Click here for more information on Media Filters.



Timeline Mode Display
This area displays the graphic appropriate to the selected mode (e.g., Category, Period).



Timeline Event Title
Displays the title of the selected event.



Timeline Event
Displays the text of the selected event.



Timeline Illustration
Thumbnails accompanying the selected event. Double click to display the illustration in Media Mode.



Media Display Area
The chosen media (picture, video, graph, etc.) is displayed in this area.



Media Source Filters
Click on the Media Source Filter to display a list of the multimedia items only. 



SmartSearch Question
Type your question in this area. Try to make the question as complete as possible.



SmartSearch Window

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topics
    SmartSearch 
 SmartSearch Tutorial



SmartSearch Results Window

 Click on the graphic above for descriptions of the various functions and features of the screen.



Boolean Dialog Box
Type the word you want to search for here.



Boolean Drop Down Menu
Click the menu to drop down the list of Boolean operators.



Subject Tree

Click a right-pointing arrow  to open branches of the list and a down-pointing arrow 
 to close the branches.



Search Subject Dialog Box
Type the subject area that you want to find in this area. If a corresponding subject exists, the tree will open in the 
box below automatically; e.g., typing “Hung” takes you directly to Hungary.



Search Subject Tree
This area opens automatically as you type your subject into the dialog box above.



Search Subject Found
This is the area in which the subject heading appears automatically if a subject corresponds to the search term 
you have entered into the dialog box above. Double click the heading to display the articles belonging to that 
subject in the title list on the left.



Video Player
The Video Player is activated when you double click on a video or animation title or thumbnail. The video will begin
to play automatically. Click on the video controls on the screen below for further explanation.

 Click on the graphic above for descriptions of the various functions and features of the screen.



Video Player Title
This area displays the title of the current video or animation.



Video Play Area
The video displays in this area when the play button is clicked. When the video is paused, a single frame is 
displayed.



Video Play Button
Click this button to play the video or animation. When the video is playing this button changes to a pause button.



Video Scroll Button
Use the Video Scroll button to move the video or animation to a specific place. Click the Scroll button with the 
mouse and drag to the spot you want to see.



Video Player Close Button
Use this button to close the Video Player.



Video Player Pause Button
Use this button to pause the current video. Click play to resume.



Video Step Buttons
Use these buttons to step through the video frame by frame, forward with the right-pointing button and reverse 
with the left-pointing button.



Video Sound Button
Use this button to adjust the sound on a video. Click the button and choose a level from the sliding bar.



Show Background

To identify a background graphic, choose Show Background from the File Menu. The corresponding picture will be
opened in Media Mode. Click the Caption Button to find the source of the picture.



Bookmarks

Use Bookmarks to keep track of lists of items for future reference. The 1998 Canadian & World Encyclopedia 
allows you to create numerous Bookmark Lists, to add or delete items and to preview and print your lists.

Bookmarks consist of folders (lists) and marked items. A folder can be opened and named in the Bookmark List 
window. Marked items can include encyclopedia titles, dictionary entries, multimedia and timeline events.

What do you want to do?
 Create Bookmark List 
 Add an Item to the Bookmark List 
 Print a Bookmark List 

 Click here to view the Bookmark List Window.



Creating a Bookmark List

1 Click on the Bookmark Button on the Toolbar.
2 In the Bookmark Window, click on the New Folder Button.
3 In the Create New Folder dialog box, type the name of the folder and click OK.

 Click here to view the Bookmark List Window.



Adding an Item to a Bookmark List

1 Choose and display the article, entry or multimedia item that you want to mark.
2 From the Bookmark Menu choose “Add”.
3 Select the folder in which you wish to store the item and click OK.

 Click here to view the Bookmark List Window.



Printing a Bookmark List

1 Click the Bookmark Button to open the Bookmark Window.
2 Click the Print Button. (You can preview the printed list by clicking the Print Preview Button.

 Click here to view the Bookmark List Window.



Bookmark List Window

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topic
    Bookmarks



Copying

You can copy text from The 1998 Canadian & World Encyclopedia to the clipboard in ASCII format. From the 
clipboard the copied text can be copied to any word processor.

 To Copy Selected Text to the Clipboard
1 Select text by dragging the mouse button (see Selecting Text)
2 Choose the "Copy Selected Text" option from the Edit Menu in the Encyclopedia Window.

Or use the keyboard command Ctrl+C (Windows) or Command+C (Macintosh).

 To Paste Selected Text into your Word Processor
1 Copy the text to the clipboard as described above.
2 Open your word processor document and click the paste button or use the command SHIFT+INSERT 

(Command+V on a Macintosh).

Note: You cannot copy multimedia items owing to copyright restrictions.



Saving

Save an article in the following manner:

 To Save an Article
1 Choose "Save Article..." from the File Menu to display the file save dialog box or click the Save Button on the 

Toolbar. By default, the program saves to the Canadian Encyclopedia directory that was created when you 
installed the program.

2 In the dialog box, type the name of the file you wish to save in the File box.



Printing

To Print an Article 
The printing option is available on the File Menu or via the Print Button on the Toolbar.

Print activates the printing function of your operating system. Printing graphics can be very slow!



Selecting Text

Select text by clicking and dragging with the mouse button pressed. (Use the left mouse button in Windows). Make
multiple selections by holding down the Crtl key (Windows) or Command key (Macintosh) while dragging the 
mouse over a new location.

Using Selected Text for Related Search
Run a SmartSearch on selected text by selecting the words, clicking the Related Button and choosing Related to 
Selected Text from the menu. The search for related articles based on your selected text proceeds automatically.



Related

Click the Related Button or select the Related Menu to gain access to the various related functions of The 1998 
Canadian & World Encyclopedia.

To Find Items Related to the Current Article or Entry
1 Click the Related Button on the Toolbar or select the Related Menu in Encyclopedia or Dictionary Mode.
2 Choose Related to Article (encyclopedia mode) or Related to Entry (dictionary mode) from the drop down 

menu.
3 Select related items from the Contents List.

To Find Items Related to Selected Text
1 Select the text for which you wish to find related items.
2 Click the Related Button on the Toolbar or select the Related Menu in Encyclopedia or Dictionary Mode.
3 Choose Related to Selected Text from the drop down menu.

To Find Subject Links for the Current Article
1 Click the Related Button on the Toolbar or select the Related Menu in Encyclopedia Mode.
2 Choose Subject Links (encyclopedia mode only) from the drop down menu.
3 Select related items from the Contents List.

To Find Internet Links Related to the Current Article
1 Click the Related Button on the Toolbar or select the Related Menu in Encyclopedia Mode.
2 Choose Internet Links (encyclopedia mode only) from the drop down menu.
3 Select related items from the Contents List.



Internet Links

Internet links connect you to information on the World Wide Web. Each link is tied to one or more articles in The 
Canadian Encyclopedia.

What do you want to do?
    Find Internet Links
    Follow an Internet Link
    Update Internet Links

Note: You must be connected to the internet to use this feature!



Finding Internet Links

 While displaying an encyclopedia article, choose Internet Links from the Related Menu or click the Related Button
on the Toolbar and choose Internet Links from the drop-down menu. If the article contains links, they are listed as 
in the following example in the entry called Montreal Expos:

To Find a List of All the Internet Links
1    Click the Contents Button.
2    Click the Internet Link Source Filter.

Note: You must be connected to the internet to use this feature!



Following an Internet Link

To follow and Internet Link
1 Choose an Internet Link by using the Related feature or by using the Internet Source Filter on the Contents 

List.
2 Click the Connect Button on the Toolbar to launch your Internet browser automatically, OR
3 Click the Copy URL Button on the Toolbar to copy the URL into your Browser.

Note: You must be connected to the internet to use this feature!



Updating Internet Links

The World Wide Web changes daily, so many of the links provided on this disk may be inactive or may have 
changed address. The 1998 Canadian & World Encyclopedia provides an easy way to update your links every 
month.
1 From the File Menu, choose Get Internet Updates
2 If your Internet connection is currently open, the process will begin immediately. If you are not currently 

connected to your provider, the updater will automatically connect you and then begin the process.

The new Internet Links and the Internet Updates are seamlessly integrated into your 1998 Canadian and World 
Encyclopedia. 

Note: You must be connected to the internet to use this feature!



Internet Updates

A reference work is often out-of-date as soon as it is published. If you are connected to the Internet you can now 
update your encyclopedia monthly. Every month, The 1998 Canadian & World Encyclopedia provides its users 
with new articles from recent issues of Maclean’s magazine.

To Update Your Internet Links
1 From the File Menu, choose Get Internet Updates
2 If your Internet connection is currently open, the process will begin immediately. If you are not currently 

connected to your provider, the updater will automatically connect you and then begin the process.

The Internet Updates are seamlessly integrated into your 1998 Canadian and World Encyclopedia. They will 
appear on your Contents List and you can search them with SmartSearch and Boolean Search.

Note: You must be connected to the internet to use this feature!



Preferences

Use Preferences to modify settings that control screen appearances and other features. Open the Preferences 
window by choosing "Preferences..." from the File Menu.

 Click here to view the Preferences Window.

Show Opening Animation
Change this option if you do not want to play the opening animation when the program begins.

Show Thumbnails in Articles
Select Show Pictures when Displaying Articles to display thumbnails (small representations of multimedia items) in
the text. Screen redraws will be faster with this preference turned off.

Save Current Article on Exit
Choose this option to display the last article viewed in the current session as the first article viewed in the next 
session. If this option is not selected, the program opens with the first article in the encyclopedia. 

Delay for Slide Show
Set the number of seconds delay before the next picture appears in the slide show.

Article Font
Changes the style of the text font.

Article Font Size
Changes the size of the text font

Highlighter Colour
Sets the colour of the highlighted text.

Article Find Colour
Sets the colour of search terms found in articles.

Cross References Colour
Sets the colour of the cross references as displayed in the text.



Show Opening Animation
Remove the check from this option if you do not want to play the opening animation when the program begins.



Show Thumbnails in Articles
Select this option to display or not display thumbnails in the text of encyclopedia articles. Screen redraws will be 
faster with this preference turned off.



Save Current Article on Exit
Choose this option to display the last article viewed in the current session as the first article viewed in the next 
session. 



Delay for Slide Show
Set the number of seconds delay before the next picture appears in the slide show.



Article Font
Changes the style of the text font.



Article Font Size
Changes the size of the text font



Highlighter Colour
Sets the colour of the highlighted text.



Article Find Colour
Sets the colour of search terms found in articles.



Cross References Colour
Sets the colour of the cross references as displayed in the text.



Preferences Window

 Click on the graphic above for descriptions of the various functions and features of the screen.



Highlighting Text

Highlighting is the equivalent of marking printed text with a yellow highlighter. (You can change the colour of the 
highlighter in Preferences.)

To highlight text, 
1 Mark the article so that it will be included in a Bookmark List. (See Adding an Item to a Bookmark List.)
2 Choose Highlight from the Bookmark Menu 
3 Drag the Highlighting Tool (holding the mouse button down) over the text you wish to highlight.

To clear highlighted text
Clear Selected text from an article by choosing "Clear Highlights..." from the Bookmarks Menu or by using the 
same mouse action that was used to highlight the text.



Annotation

Use Annotation to add notes to entries.

To Add an Annotation
1 Mark the article so that it will be included in a Bookmark List. (See Adding an Item to a Bookmark List.)
2 Choose Annotation from the Bookmark Menu. 
3 Drag the cursor, which now resembles a post-it note, to the part of the article where you want the note to 

appear.
4 Click the mouse to drop the note.
5 Double click the Post-it icon to bring up the Article Note window
6 Type your note and click the OK Button.
7 The Post-it icon changes to show that a note has been added.

To Read an Annotation
Double click the Post-it icon to bring up the Article Note Window.



Find Word

To Search for any term or terms in the text of the Current Article.
1 Choose Find Word from the Article Menu in Encyclopedia Mode to open the Word Find window.
2 Enter your term or terms in the Locate entry box.
3 Click the Begin Search Button at the bottom of the window.
4 Click the Box Icon on the scroll bar to go to the next match for the term.

Match Case
Select "Match Case" to find terms that match the case of your search item; for example, to find Floral and ignore 
floral, type the expression Floral and choose Match Case.

Match Whole Word
Select "Match Whole Word Only" to match all the letters of your search term; for example, with this option selected 
the search item visitor would not find the word visitors. With this option not selected, the search expression visit 
would locate the words visit, visitor, visitation, etc.



Zoom In/Zoom Out

Use the zoom feature to increase or decrease the area taken up by the article text in Encyclopedia Mode. To Zoom 
In (make the text area larger) click the Zoom Button on the Toolbar. To Zoom Out, click the Zoom Out Button.

Note: This function is not the same as Scaling the Product Window.



Scaling the Product Window

The 1998 Canadian & World Encyclopedia allows you to change the size of the encyclopedia window to suit your 
desktop.

To maximize the size of the encyclopedia window, 
 click the Maximize Button on the upper right-hand side of the window.

To minimize the size of the encyclopedia window, 
 click the Minimize Button on the upper right-hand side of the window.

To change the dimensions of the window, 
 move the mouse cursor to the edge of the window and drag it to the desired location.



History List

The History List keeps track automatically of the list of articles viewed previously in the current session. 

To Access the History List
 Open the Article Menu in Encyclopedia Mode and choose History:



Search History

Search History keeps track automatically of the Boolean and SmartSearches performed in the current session.

To Access the Search History
 Open the Search Menu in Encyclopedia Mode and choose Search History:



Random Display of Articles

Use Random display of articles to browse through the articles of the encyclopedias randomly.

To Browse Randomly
 Click the Random Button on the Toolbar in Encyclopedia Mode.



Prime Ministers Disk

This new CDROM on The Lives & Times of the Prime Ministers, produced by EXCITE with support from Rogers 
Communications and the Canadian Broadcasting Corporation, invites students and all Canadians to explore the 
lives and times of the twenty people who have served in Canada's highest office. 

To run the PM disk you must exit The 1998 Canadian & World Encyclopedia and insert the PM disk.



Media Subject Browser

Use the Media Subject Browser to search the multimedia on The 1998 Canadian & World Encyclopedia by subject.

How to Use the Subject Media Browser
1 Go to Media Mode by clicking the Media Tab .
2 Click the Subject Button on the Toolbar in Media Mode
3 If the Subject Tree is not open, click the Open Subject Tree Button.
4 Open or close parts of the subject tree using the down-pointing or right-pointing arrows.
5 Adjust the Media Source Filters to show all or some of the types of media in your list.

 Click here to view the Media By Subject Screen.



Media By Subject Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.



Media Subject Dialog Box
Enter the name of the multimedia item that you are searching for in this area.



SmartSearch Results Source Filters
Select these filters to restrict the results list to the chosen sources.



SmartSearch Results Media Filters
Select these filters to restrict the results list to the chosen sources.



SmartSearch Results List
A SmartSearch Results lists the items in order of their possible relevance to the query that you have entered.



Boolean Search Screen

 Click on the graphic above for descriptions of the various functions and features of the screen.

Key Related Topic
    Boolean Search 



Bookmark Folders
Create Bookmark Folders to organize your Bookmark lists.



Media Selected Subject
Select the subject by clicking on it in the subject tree. A list of items belonging to that subject appears in the 
Contents List.



Legend

Legends list the available hot links to a clickable map or photograph.
Display the Legend by clicking the Legend Button or (Windows only) by clicking the right mouse button.



Bookmark Item List
This area displays the items in the current Bookmark Folder.



Media Subject Tree
Click the right-pointing arrows to open the branches of the tree and the down-pointing arrows to close them. Select 
a subject by double clicking.



Media Source Filter On

Select this source filter to show media titles only in the contents list.



SmartSearch Results Query Area

Shows the current query entered in the SmartSearch window.



Subject Browser Chosen Subject

Shows the subject chosen from the subject tree. Double click to display the article titles in that subject.



Subject Browser Subject Titles

Shows the titles of the chosen subject (in this case Acts and Statutes).



Month and Day Drop-down Menus
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How Do I?

Finding things:
 How do I Find all the articles in The Canadian Encyclopedia?
 How do I Find a list of Maclean’s articles?
 How do I Find a specific Timeline event, such as Sir John A. Macdonald’s birthday?
 How do I Find multimedia for a certain subject area, such as birds?
 How do I Find out when to use SmartSearch and when to use Boolean Search?
 How do I use the filters to narrow the contents list?
 How do I Find articles in a certain Subject?
 How do I Find a Definition in the dictionary?
 How do I use Accents in my Boolean searches and SmartSearches?
 How do I Find the Pronunciation Guide for the Dictionary?

Getting things to Work
 How do I use QuickTime VR?
 How do I follow hotspots on a map?
 How do I change the font style and size of the text?
 How do I stop the opening animation from playing every time I start the program?
 How do I get my Internet updates each month?
 How do I update my Internet links?
 How do I get in touch with the publisher or the editor or technical support?
 How do I get a movie or animation to run smoother?

Using the Program
 How do I start a Bookmark List?
 How do I add an item to a Bookmark List?
 How do I copy an Article or Definition to my word processor?
 Why can’t I copy a Photograph?
 How do I Print an Article or Definition?



Finding All the Articles in The Canadian Encyclopedia

To find all the articles from The Canadian Encyclopedia 
1 Click the Contents Button 
2 Click The Canadian Encyclopedia Source Filter 



Finding Maclean's Articles

To find all the articles from Maclean’s Magazine 
1 Click the Contents Button 
2 Click the Maclean  ’  s Source Filter   



Finding a Timeline Event

To find a specific event, for example, the birthday of John A. Macdonald, in the Timeline
1 Click the SmartSearch Button 
2 Type your query “when was John A. Macdonald’s birthday?” in the search window
3 Click Begin Search 
4 In the results screen, click the Timeline Source Filter 



Finding Multimedia on a Specific Subject

To find a list of multimedia on a specific subject, e.g., Birds
1 Click the Media Tab to enter Media Mode
2 Click the Subject Button on the Toolbar
3 Click the down-pointing arrow next to the subject Animals
4 Choose the topic Birds by double clicking
5 View the list of media in the list window on the left.



When to Use SmartSearch or Boolean Search

When is it appropriate to use SmartSearch or Boolean Search 
1 Use Boolean Search when you are searching for single words or when you know the specific relationship 

between more than one term, e.g., Windsor AND Ontario.
2 Use SmartSearch for more general queries when you are digging deeper into a subject and are trying to find 

associations that might not have otherwise been obvious to you.



Using Filters to Narrow the Contents List

How to use Filters to narrow or expand a Contents List
1 Click the Contents Button to display a complete list of everything on the disk.
2 By default all titles appear.
3 Click on one of the Source Filters to display items from that source, e.g., The Canadian Encyclopedia Filter to 

show the entry titles from The Canadian Encyclopedia.
4 Click on another filter to add items from that source.



Searching for Articles on a Certain Subject

How to find articles on a certain Subject
1 Click the Encyclopedia Tab to enter Encyclopedia Mode.
2 Click the Subject Button.
3 Choose Browse to browse through the subject tree, OR
4 Choose Search to search the subject tree.
5 Find your subject and double click to display the titles on the left

 Click here for more detailed information on how to Browse the Subject List.
 Click here for more detailed information on how to Search the Subject List.



Changing Font Style and Size

How to change the style and size of the text font.
1 Choose Preferences from the File Menu.
2 In the Preferences Window, click on the Article Font drop-down menu.
3 Choose a font from the list. (Of course you are limited to the fonts available on your system).
4 Choose a size from the size menu.
5 Click the Apply Button to accept the changes.

 Click here for more information on the Preferences Window.



Stopping the Opening Animation

How to stop the Opening Animation from playing
1 Choose Preferences from the File Menu.
2 In the Preferences Window, unclick on the Play Opening Animation selection box.

 Click here for more information on the Preferences Window.



Getting Internet Updates

How to Update Your Internet Updates
1 From the File Menu, choose Get Internet Updates
2 If your Internet connection is currently open, the process will begin immediately. If you are not currently 

connected to your provider, the updater will automatically connect you and then begin the process.

The new Internet Updates are seamlessly integrated into your 1998 Canadian and World Encyclopedia. 



Updating Internet Links

How to Update your Internet Links
1 From the File Menu, choose Get Internet Updates
2 If your Internet connection is currently open, the process will begin immediately. If you are not currently 

connected to your provider, the updater will automatically connect you and then begin the process.

The new Internet Links are seamlessly integrated into your 1998 Canadian and World Encyclopedia. 



Getting in Touch with the Publisher

Contacting TCE Technical Support
To contact The Canadian Encyclopedia technical support, call 1-800-647-0639.

Contacting the TCE WEB site
The Canadian Encyclopedia site on the World Wide Web provides information about the creation of The Canadian 
Encyclopedia, updates of encyclopedia articles, a selection of new articles from Maclean's magazine, guides for 
teachers and students and other features. 

The address of the 1998 Canadian and World Encyclopedia Web Site is http://www.tceplus.com.

Contacting TCE Sales
To contact The Canadian Encyclopedia sales department, call 1-800-788-1074 (Canada wide and US).



Getting a Movie to Run Smoother

Videos and animations will work smoothly only if QuickTime has been correctly installed during installation. The 
speed and smoothness of the video depend on the speed of your processor, the quality of your video card and the 
amount of RAM available. To improve performance, close any other programs that are running to free up memory 
and processing power.



How do I start a Bookmark List?

To start a new Bookmark List
1 Click on the Bookmark Button on the Toolbar.
2 In the Bookmark Window, click on the New Folder Button.
3 In the Create New Folder dialog box, type the name of the folder and click OK.



How do I add an item to a Bookmark List?

To add an item to a Bookmark List
1 Choose and display the article, entry or multimedia item that you want to mark.
2 From the Bookmark Menu choose “Add”.
3 Select the folder in which you wish to store the item and click OK.



How do I copy an Article or Definition to my word processor?

To Copy an Encyclopedia Article, Dictionary Definition or Timeline Event
1 Display the item
2 Choose Copy from the Edit Menu

The item is now available to be pasted into another program.



Why can't I copy a Photograph?

Because the copyright of most of the photographs in The 1998 Canadian and World Encyclopedia is retained by 
the photographers, there is no function to copy them into other programs. 



How do I Print an Article, Definition, Event or Multimedia Item?

To Print an item
1 Display the Encyclopedia Article, Multimedia item, Dictionary Definition or Timeline Event
2 Choose Print Preview from the File Menu if you wish to preview the item
3 Choose Print from the File Menu or click the Print Button on the Toolbar to print



Example 1: Toolbar in Encyclopedia Mode

This is the Toolbar in Encyclopedia Mode showing the functions currently available. Note that the Back Button is 
disabled in this case because the user has viewed only one article in this session. 



Example 2: Toolbar in Media Mode

This is the Toolbar in Media Mode while a picture is displayed. Note that the Sound Button is disabled since there is 
no sound attached to this picture. The Caption Button is enable since this picture has a caption.



Example 3: Media Toolbar with Hotspot Feature

This is the same Toolbar in Media Mode while a map with hotspots is showing. Note that since there is no caption for
this map, the Caption Button is disabled. However, a new button, Legend, has appeared. Click this button to see a list
of all the hotspots attached to the map.



Example 4: Media Toolbar with VR

This is the same Toolbar in Media Mode while a QuickTime VR is showing. Note that the Print Button is disabled 
since you cannot print a VR and a VR Button has appeared. Click the VR Button for special instructions on how to 
use QuickTime VR.



SmartSearch Tutorial

Finding the information you need in a large collections of documents, such as an encyclopedia, requires some skill
and ingenuity. SmartSearch™ is flexible and powerful enough to help you in your searches, but it requires some 
understanding and a bit of practice.

Greater Scope in Searching
The 1998 Canadian and World Encyclopedia, which contains over 4000 multimedia elements as well as some 20 
million words of text, can be accessed by traditional search methods, such as, title, subject, cross referencing, and
full Boolean Search with AND, OR, NOT, and NEAR operators. SmartSearch™ differs from these methods by 
offering greater scope and precision for broad queries that cannot be neatly categorized in advance.

SmartSearch™ recognizes and addresses the fact that topics or ideas are formulated in vastly different ways by 
different individuals. Since the process of searching for information requires a "match" between a query formulated
by one individual, the user, and material written by other individuals, the authors, it is unlikely that the words or 
expressions to be matched will be identical. Thus, Boolean Search, which is based on the exact matching of words
or phrases often does not find the appropriate article or it identifies far too many irrelevant articles.

Other Hindrances in Finding Matches
Another hindrance in finding a good match for a given query is the lack of sufficient information in the query itself 
or in the document dealing with the subject matter. Just as in verbal communication, where background 
information is often taken for granted, in written queries and documents certain knowledge or context are also 
often presupposed. For example, searching for the single word, bridge, without mentioning cards or game will 
usually yield many irrelevant returns pertaining to bridges built over water or other obstacles. On the other hand, 
searching for pink AND flower, in the 1997 TCE+, will not yield begonia, while pink AND flowers will!

What kind of bridge do you mean when you search for "bridge"? Without the context, there is no way to know if 
you mean the game or the structure over troubled waters!

As we shall see, SmartSearch™ offers several approaches to circumvent these problems.

 Go to SmartSearch Tutorial Part 2



SmartSearch Tutorial: Part Two

The Process of Selecting and Ranking Articles
Before demonstrating the effectiveness of SmartSearch™ through concrete examples, let us briefly review the 
process of selecting and ranking articles that are deemed relevant to the query. Before a comparison is made, the 
words in the query and in the articles are first reduced to their base forms. 

Augmenting the Query
In the begonia example, SmartSearch™ recognized that the user could very well be interested in an article 
containing the word flowers (plural) though they had only typed flower (singular) along with their other search term 
pink and returned the begonia article in its search results. Short queries are assumed to be incomplete, that is, 
lacking background information, and they are often augmented with additional relevant words in SmartSearch™ .

The Tuner
The additional words added to make queries more complete can be viewed and their relative contribution to the 
query adjusted by invoking the "tuner." For example, a short query with the word ulcer will be augmented with 
duodenal, peptic and ulcers; the tuner then can be adjusted to allow for the relative contribution of each and every 
word in the query. Thus, the tuner gives the user enormous flexibility in refining the original query, so that the 
search results offer a high degree of "precision" and "recall."

A SmartSearch™ query for the word ulcer reveals 
relevant words added to the query.

 Go to SmartSearch Tutorial Part 3



SmartSearch Tutorial: Part Three

The Query Results
After reducing query words to their base form and augmenting the query with additional relevant terms, 
SmartSearch™ proceeds to extract, from the entire data base available to it, those articles containing words 
matching the query words. The selected articles are then ranked in order of relevance to the query with the most 
relevant articles appearing at the top of the list. 

Note that, when using Boolean Search (left), the articles in the results screen are listed in alphabetical order, which
will likely bury the most relevant results in a long list of less useful titles. 

Boolean Search Results SmartSearch™ Results

If we search for the word renal, the results list in the Boolean Search are alphabetical while those in the 
SmartSearch™ give due emphasis to kidney diseases. Note that the Boolean search did not even list an entry 
called "kidney."

Ranked Results in SmartSearch™
The ranking process used in SmartSearch™ takes into account such quantitative traits as whether or not the word 
match is an exact one or one with an inflected form (flowers and flower), whether the word is rare or common in 
the entire database, the word's frequency and position(s) within the article, etc. By considering the article layout 
and the location of the matching words, SmartSearch™ can offer another very useful feature, namely, it can often 
accurately pinpoint the portion of the article that is most relevant to the query. Users can observe this feature by 
scrolling down through the ranked list of articles and viewing them in the article window. 

 Click here to view the results list and the highlighted terms.

 Go to SmartSearch Tutorial Part 4





Renal Query Results

The Article Window pinpoints the area of the longer article "Immunity" which is relevant to the SmartSearch™ for 
"renal." Note that the article text does not even include the search term, but does include some very relevant 
terms, such as “kideney”.



SmartSearch Tutorial: Part Four

Examples
In the following examples, the searches encompass all the articles in the 1997 TCE+, that is, both the Canadian 
and Columbia Encyclopedias, as well as, the Maclean’s articles.

Example 1: Discovery of Insulin
In the first example, let us search for information pertaining to the discovery of insulin, as it turns out, a great 
Canadian contribution to world medicine!

1 Begin by clicking on the SmartSearch button, then
2 Type: “discovery of insulin”. 
3 Click on the Begin Search Button . 

Following these steps results in a ranked list of articles dealing with various aspects of insulin and other words 
associated with it. Examining each of the articles listed is quite revealing. SmartSearch™ homes in on the relevant
section of each article and highlights the query words. 

 Click here to view the results list for the above query.

 Go to SmartSearch Tutorial Part 5



Insulin Query Result

Double click one of the titles on the left to display the article or multimedia item. The search terms are highlighted.



SmartSearch Tutorial: Part Five

Now let us emphasize the discovery aspect of the query.
1 Click on the SmartSearch Button. 
2 Click on the Tuner Button. (The query words, discovery of insulin, are already present in the search window, 

since they were retained from our last search.) 
3 Minimize the weight of the words diabetes, glucose,hormone, mellitus, pancreas, pancreatic and peptide by 

sliding the respective sliders all the way to the left. 
4 Click on the Begin Search Button. 

By decreasing the weight of the general terms in the 
query, we emphasize the discovery aspect of the query. 
Most of the results now focus on the co-discoverers of 
insulin, Banting, Collip, Best and Macleod.

The resulting list is more weighted towards the aspect of discovery than the previous list. However, there are now 
articles at the bottom of the list that have nothing to do with the discovery of insulin. Since this is a ranked list, 
there is no need to look beyond the most relevant articles at the top of the list. 

 Click here to view the results list for the adjusted query.

 Go to SmartSearch Tutorial Part 6



Adjusted Query Result



SmartSearch Tutorial: Part Six

Example 2: Thunderstorms

In our second example, we search for the causes of thunderstorms and use the Related feature to refine our 
search.

1 Click on the SmartSearch Button . 
2 Type: “what causes thunderstorms?” 
3 Click on the Begin Search Button (or press Enter). 

Using the Related Feature in Conjunction with SmartSearch 
SmartSearch™ also allows users to retrieve information "by example"; that is, if a given article contains 
information of interest to the user, the most relevant phrase, sentence, paragraph, section or any combination of 
these elements can be selected and interpreted by SmartSearch™ as a user query through the Related feature. 

Using the Related button when no text has been selected, assumes that the entire article is considered to be the 
query. Using the entire article as the query works well for succinct and homogeneous articles. However, for long 
and diverse articles, it is usually much more effective simply to select only the most appropriate portion(s) within 
the article.

To use the above query on thunderstorms as an example, 
1    Select from the Canadian article entitled, Thunderstorm, the following, "lightning may occur, the cumulonimbus 
cloud having become electrically charged" 

2 Click the Related Button (or the Related Menu) and choosing “Related to Selected Text” from the menu, to 
obtain a list of articles that more specifically concentrate on the lightning aspects of thunderstorms. 



By selecting text within the entry on Thunderstorm, we will find results that concentrate more on clouds and 
lightning.

 Click here to view the ranked results from the Related query.

 Return to SmartSearch Tutorial Part 1



Related Query Result



Pronunciation Key

To find the key to pronunciation in the Dictionary

1 In Dictionary Mode, go to the Options Menu
2 Choose Pronunciation Key
3 The key appears in the lower left



SmartSearch Help Button

Click this button to get help with the SmartSearch Window.



Headword

Word or words forming the heading (or title) of a dictionary entry.



Dictionary Search Box

Enter the term you wish to search for in this box.



Dictionary Search Button

Click this button to search the French-English dictionary and the thesaurus. Note that this button is disabled for the
Gage Canadian Dictionary since you can use SmartSearch and Boolean Search on that dictionary.



Definition Window

This window contains the definition for the current headword. The Pronunciation Key is available off the Options 
Menu.



Synonyms

This window contains a list of synonyms for the currently chosen headword.



Synonym Definitions

This window contains definitions for the currently chosen synonym. 



Category Drop Down List

In the Timeline, this shows a list of all categories. Click to choose a category.



Category Events List

Lists the events in the currently chosen category. Click a title to display an event.
x



Abbreviations

Abbreviations are used throughout the text of The Canadian Encyclopedia Plus. Most of these 
abbreviations are listed below. Go to the section of the alphabet that contains the abbreviation and click 
the abbreviation to display the full term. Click "Back" on the menu bar at the top of the screen to return to 
this screen.

 Abbreviations A-B

 Abbreviations C

 Abbreviations D-E

 Abbreviations F-G

 Abbreviations H-L

 Abbreviations M

 Abbreviations N-O

 Abbreviations P-Q

 Abbreviations R-S

 Abbreviations T-U

 Abbreviations V-Y



Abbreviations A-B
AAA 
Adm 
aka 
Ala 
alt 
Alta 
approx 
Apr 
ARC 
Ariz 
Ark 
Assn 
Asst 
Atty Gen 
Aug 
B 
b 
BA 
bap 
BBC 
BC 
BComm 
Bdy 
BEd 
BLitt 
Blvd 
BMus 
BNA 
Bor 
Brig-Gen 
BSc 
BSW 
Btu 
bu 



Amateur Athletic Association



Admiral



Also known as



Alabama



altitude



Alberta



approximately



April



Alberta Research Council



Arizona



Arkansas



Association



Assistant



Attorney General



August



Bay



born



Bachelor of Arts



baptized



British Broadcasting Corporation



British Columbia



Bachelor of Commerce



boundary



Bachelor of Education



Bachelor of Literature



Boulevard



Bachelor of Music



British North America



Borough



Brigadier-General



Bachelor of Science



Bachelor of Social Work



British Thermal Unit, the amount of heat required to raise the temperature of one pound of water one 
degree Fahrenheit at 39.2°F



bushel, unit of dry measure, equal to 4 pecks, or about 35.2 litres



Abbreviations C
C 
c 
c 
cA 
CA 
CAF 
Calif 
Capt 
CAUT 
CBC 
CBE 
CCF 
CCL 
Cdr 
CEF 
CEGEP 
CFB 
CFDC 
CFL 
CGA 
Chan 
cm 
CMA 
CMG 
CNR 
CNTU 
Co 
Col 
Coll 
Colo 
Comm 
Conn 
Const 
Corp 
COTC 
Cpl 
CPR 
CRBC 
CRTC 
CTC 
Czech 
Cy 



City



census



circa



Census Adjusted



Chartered Accountant



Canadian Armed Forces; Canadian Air Force



California



Captain



Canadian Association of University Teachers



Canadian Broadcasting Corporation



Companion of the Order of the British Empire



Co-operative Commonwealth Federation



Canadian Congress of Labour



Commander



Canadian Expeditionary Force



Collège d'enseignement général et professionel



Canadian Forces Base



Canadian Film Development Corporation



Canadian Football League



Certified General Accountant



Channel



centimetre, a unit of length equal to 1/100 of a metre or 0.3937 inch



Census Metropolitan Area



Companion of the Order of St Michael and St George



Canadian National Railways



Confederation of National Trade Unions



Company



Colonel



College



Colorado



Community



Connecticut



Constable



Corporation



Canadian Officer Training Corps



Corporal



Canadian Pacific Railway



Canadian Radio Broadcasting Commission



Canadian Radio-Television and Telecommunications Commission



Canadian Transport Commission



Czechoslovakia



County



Abbreviations D-E
d 
Dak 
Dan 
db 
Dec 
Del 
Den 
Dept 
DEW 
DFC 
DIAND 
Dir 
Dist 
Div 
DM 
DMus 
DSC 
DSO 
DSW 
dwt 
E 
e 
ed 
EEC 
eg 
elev 
EMR 
Eng 
est 
et al 
etc 



Died



Dakota



Danish



decibel, a unit used to express relative difference in power, usually between acoustic or electric signals, 
equal to ten times the common logarithm of the ratio of the two levels



December



Delaware



Denmark



Department



Distant Early Warning



Distinguished Flying Cross



Department of Indian Affairs and Northern Development



Director



District



Division



District Municipality



Doctor of Music



Distinguished Service Cross



Distinguished Service Order



Doctor of Social Work



deadweight, the weight of an inert mass



East



Estimate



Editor, edited by, edition



European Economic Community



(exempli gratia) for example



Elevation, height above the level of the sea



Department of Energy, Mines and Resources



England



Established



(et alii) and others



(et cetera) and so forth



Abbreviations F-G
F/O 
fd 
Feb 
ff 
fl 
Fla 
Flt Lt 
Flt Off 
Flt Sgt 
Fr 
Fri 
FRSC 
Ft 
g 
Ga 
GATT 
GDP 
Gen 
Ger 
GHz 
Gk
GNP 
Gov Gen 
govt 
GSC 
GW 



Florida



Flying Officer



Founded



February



folios, a leaf of a manuscript or book, a page number



(floriat) flourished



Flight Lieutenant



Flight Officer



Flight Sergeant



Father



Friday



Fellow of the Royal Society of Canada



Fort



Gram, a metric unit of mass and weight, equal to one-thousandth of a kilogram



Georgia



General Agreement on Tariffs and Trade



Gross Domestic Product



General



Germany



gigahertz, one billion hertz



Greek



Gross National Product



Governor General



Government



Geological Survey of Canada



Gigawatt, one billion watts



Abbreviations H-L
h 
ha 
Ham 
HBC 
hg 
hm 
HMCS 
hp 
hr 
Hz 
I, Is 
ie 
Ill 
Inc 
Ind 
Insp 
Inst 
Int 
Intro 
IR 
Ire 
Jan 
k 
Kans 
KB 
KC 
KCMG 
kg 
kHz 
kL
km 
km/h 
kPa 
kW 
kWh 
Ky 
L 
La 
Lab 
Lat 
lat 
LC 
LID 
LLD 
Lk, Lks 
long 
Lt-Gov 
Ltd 
Ltée 



Hour



Hectare, a metric unit of area equal to 100 acres or 2.471 acres



Hamlet



Hudson's Bay Company



Hectolitre, a metric unit of capacity or volume equal to 100 litres in liquid measure (or 105.7 liquid quarts) 
and a metric unit of capacity or volume equal to 100 litres or 90.8 dry quarts in dry measure



hectometre, a metric unit of    measure equal to 100 metres



Her Majesty's Canadian Ship



horsepower, a unit of power equal to 745.7 watts or 33 000 foot-pounds per minute



Hour



hertz, a unit of frequency equal to one cycle per second



Island, Islands



(id est) that is



Illinois



Incorporated



Indiana



Inspector



Institute, Institution



International



Introduction



Indian Reserve



Ireland



January



Kilo, Kilogram, a basic measure of mass and weight in the metric system, equal to the weight of a 
platinum and iridium cylinder kept at the International Bureau of Weights and Measures, near Paris; equal
to about 2.2046 pounds



Kansas



Knight of the Bath



King's Counsel



Knight Commander of St Michael and St George



Kilogram, the fundamental unit of mass in the International System, equal to the weight of a platinum and 
iridium cylinder kept at the International Bureau of Weights and Measures, near Paris; equal to about 
2.2046 pounds



Kilohertz, one thousand hertz



Kilolitre, one thousand litres



Kilometre, one thousand metres



kilometres per hour



kilopascal



Kilowatt, one thousand watts



Kilowatt hour



Kentucky



Litre, a metric unit of volume equal to a cubic decimetre, approximately 1.056 liquid quarts or 0.908 dry 
quart



Louisiana



Labrador



Latin



Latitude



Lower Canada



Local Improvement District



Doctor of Laws



Lake, Lakes



Longitude



Lieutenant-Governor



Limited



Limitée



Abbreviations M
m 
m/s 
MA 
Maj 
Man 
Mar 
Mass 
MBE 
Md 
MD 
Me 
MEng 
mg 
Mgr 
mHz 
Mich 
MIL 
min 
Minn 
Miss 
mj 
mL 
MLA 
mm 
MNA 
Mo 
Mont 
MP 
MSc 
MSW 
Mt 
Mt A 
Mtn, Mts 
MW 



Metre, the basic metric unit of length, defined as one ten-millionth of the distance on the Earth's surface 
from the pole to the Equator.



Metres per Second



Master of Arts



Major



Manitoba



March



Massachusetts



Member of the Order of the British Empire



Maryland



Doctor of Medicine



Maine



Master of Engineering



Milligram, one-thousandth of one gram



Monseigneur



Megahertz, unit of frequency equal to one million hertz



Michigan



Military Reserve



Minute



Minnesota



Mississippi



megajoule, unit of energy equal to one million joules



millilitre, one thousandth of one litre



Member of the Legislative Assembly



millimetre, one thousandth of one metre



Member of the National Assembly



Missouri



Montana



Member of Parliament



Master of Science



Master of Social Work



Mount



Mountain, Mountains



Mount Allison University



Megawatt, one million watts



Abbreviations N-O
N 
N Dak 
N Mex 
NAC 
NB 
NC 
nd 
NDHQ 
NDP 
NEB 
Nebr 
NEP 
Nev 
NFB 
Nfld 
NH 
NHL 
NJ 
No 
Nor 
NORAD 
Nov 
NRC 
NS 
NSAC 
NSCAD 
NTS 
NWC 
NWT 
NY 
OAC 
OBE 
Oct 
OECD 
Okla 
OMI 
Ont 
OPEC 
Oreg 



North



North Dakota



New Mexico



National Archives of Canada



New Brunswick



North Carolina



No Date



National Defence Headquarters



New Democratic Party



National Energy Board



Nebraska



National Energy Policy



Nevada



National Film Board



Newfoundland



New Hampshire



National Hockey League



New Jersey



Number



Norway



North American Air Defence



November



National Research Council



Nova Scotia



Nova Scotia College of Art and Design



Nova Scotia Agricultural College



National Topographic Survey



North West Company



Northwest Territories



New York



Ontario College of Art



Order of the British Empire



October



Organization for Economic Co-operation and Development



Oklahoma



Oblates of Mary Immaculate



Ontario



Organization of Petroleum Exporting Countries



Oregon



Abbreviations P-Q
Pa 
PAC 
PC 
PCO 
PEI 
Pen 
pH 
PhD 
PM 
PMO 
PO 
pop 
POW 
PQ 
Prem 
Pres 
pseud 
Pt 
publ 
QC 
Que 



Pennsylvania



Public Archives of Canada (now National Archives of Canada)



Progressive Conservative; Progressive Conservative Party



Privy Council Office



Prince Edward Island



Peninsula



Hydrogen-ion Concentration



Doctor of Philosophy



Prime Minister



Prime Minister's Office



Post Office, Petty Officer



Population



Prisoner of War



Parti Québécois



Premier



President



Pseudonym



Point



Published



Queen's Council



Quebec



Abbreviations R-S
R 
R & D 
RAF 
RCAF 
RCN 
RD 
Rear-Adm 
Rg 
repr 
rev 
RFC 
RI 
RM 
RMC 
RN 
RSC 
Ry 
S 
s 
S Dak 
Sask 
SC 
Scot 
Sen 
Sept 
SFU 
Sgt 
SI 
SJ 
Soc 
Sol Gen 
Span 
Sqn Cdr 
Sqn Ldr 
SS 
St 
Ste 
Str 
Supt 
Switz 



River



Research and Development



Royal Air Force



Royal Canadian Air Force



Royal Canadian Navy



Rural District



Rear-Admiral



Regiment



Reprinted



Revised



Royal Flying Corps



Rhode Island



Rural Municipality



Royal Military College of Canada



Registered Nurse



Royal Society of Canada



Railway



South



Second



South Dakota



Saskatchewan



South Carolina



Scotland



Senator



September



Simon Fraser University



Sergeant



Système International des Unités



Society of Jesus



Society



Solicitor General



Spanish



Squadron Commander



Squadron Leader



Ship Title, steamship



Saint



Sainte



Strait



Superintendent



Switzerland



Abbreviations T-U
T 
t 
TCA 
Tenn 
Terr 
Tex 
TLC 
tr, trans 
TV 
TWh 
Twp 
U 
U de M 
U Leth 
U Man 
U of A 
U of C 
U of O 
U of T 
U Vic 
U Wpg 
UBC 
UC 
UCCB 
UK 
UN 
UNB 
UNESCO 
unpubl 
UP 
UPEI 
UQ 
UQUAC 
UQAM 
UQAR 
UQTR 
US 
USSR 



Abbreviations V-Y
Va 
Vl 
vol 
VP 
Vt 
W 
Wash 
Wisc 
WLU 
WO 
WWI 
WWII 
Wyo 
YMCA 
YT 
YWCA 



Town



Tonne, metric ton, 1 million grams



Trans-Canada Airlines



Tennessee



Territory



Texas



Trades and Labor Congress



Translated



Television



terawatt hours, a trillion hours



Township



University



Université de Montréal



University of Lethbridge



University of Manitoba



University of Alberta



University of Calgary



University of Ottawa



University of Toronto



University of Victoria



University of Winnipeg



University of British Columbia



Upper Canada



University College of Cape Breton



United Kingdom



United Nations



University of New Brunswick



United Nations Educational, Scientific and Cultural Organization



Unpublished



Unincorporated Place



University of Prince Edward Island



Université du Québec



Université du Québec à Chicoutimi



Université du Québec à Montréal



Université du Québec à Rimouski



Université du Québec à Trois-Rivières



United States of America



Union of Soviet Socialist Republics



Virginia



Village



Volume



Vice-President



Vermont



West



Washington



Wisconsin



Wilfrid Laurier University



Warrant Officer



World War One



World War Two



Wyoming



Young Men's Christian Association



Yukon Territory



Young Women's Christian Association



Anagram Button

The Anagram Button is located in the Dictionary Window. Click the button with the mouse to find words containing the
same letters as the current word.



Browse Subject Button

Click the Browse Subject Button to browse through the subject tree. This button toggles with the Search Subject 
Button; i.e., it appears when you are in Search Subject mode and the Search Subject Button appears when you are in
Browse Subject mode.



Conjugate Button

Click the Conjugate Button to conjugate a French verb (available only in the French-English mode.



Definition Button

Click this button in the Dictionary to find a dictionary or thesaurus entry on the term entered in the search box.



Search Button

In the Dictionary click this button to find all the entries that contain the search term or terms.



Search Subject Button

 

Click the Search Subject Button to browse through the subject tree. This button toggles with the Browse Subject 
Button; i.e., it appears when you are in Browse Subject mode and the Browse Subject Button appears when you are 
in Search Subject mode.



Synonym Button

The Synonym Button appears in the Dictionary when Thesaurus has been activated. Enter the term and click the 
button to find a list of synonyms.



Dictionary Tab

Choose this option to go to the Dictionary screen.



Gage Dictionary Button

Click this button on the Dictionary screen to display the Gage Canadian Dictionary.



Thesaurus Button

Click this item from the menu or click the Thesaurus button to go to the Thesaurus.



Gage Dictionary/Thesaurus Button

Select this item from the menu to display definitions from both the Gage Dictionary and the Thesaurus.



French to English Button

Select this item from the menu or click the French-English button to translate a word from French to English.



English French Button

Select this item from the menu or click the English-French button to translate a word from English to French.



Translation Button

The Translation Button appears in the Dictionary when French-English or English-French are chosen. Click the button
to translate the term you have entered.



Wildcard Button

In the Dictionary, click this button to use wildcards to search for dictionary items when you are not sure of the spelling 
of your term. The button lights up only when you enter a wildcard (* or ?).



Advanced Button

The Advanced Button provides access to the advanced search screen in which the user can enter Boolean operators.
This button toggles with the Basic Button.



Begin Search Button

Click this button to start your search once you have entered your search term.



Cancel Button

Click the Cancel Button to stop your search.



Change Button

Click the Change Button in order to replace the search term to the suggested alternate term in the list box. 



Close Button

The Close Button closes the active window.



Clear Entry Button

Click the Clear Entry Button to clear the search dialog box.



Delete Folder Button

Click the Delete Folder Button to remove a folder and its contents from your Bookmark List.



Delete Article Button

Click the Delete Article    Button to remove an article from your Bookmark Folder.



Canadian Source Filter

Select this filter to display a list of all of the article titles from The Canadian Encyclopedia in the Contents List.



Canadian/Columbia Source Filter

Select this filter to display a list of all of the article titles from both the Canadian and Columbia encyclopedias in the 
Contents List. 



Maclean's Source Filter

Select this filter to display a list of all of the articles from Maclean's magazine in the Contents List. 



Internet Source Filter

Select this filter to display a list of all of the URLs as well as any updated articles you have downloaded from The 
Canadian Encyclopedia    web site in the Contents List. 



Multimedia Source Filter

Select this filter to display a list of all of the multimedia items in the Contents List. Use this filter in conjunction with the
Media Filters to display types of media, such as video or sounds.



Timeline Source Filter

Select this filter to display a list of all of the Timeline events in the Contents List.    To access the article associated 
with each event click Related on the Toolbar and choose between Related to Event and Related to Selected Text.



Gage Dictionary Source Filter

Select this filter to display a list of all of the definitions contained in the Gage Canadian Dictionary in the Contents 
List. 



Picture Media Filter

Select this filter to display a list of all of the articles containing pictures as well as a list of all of the pictures. To see 
only a list of the pictures, first click the Multimedia Source filter.



Video/Animation Media Filter

Select this filter to display a list of all of the articles containing videos and animations as well as a list of all of the 
videos and animations. To see only a list of videos and animations, first select the Multimedia Source filter.



Map Media Filter

Select this filter to display a list of all of the articles containing maps as well as a list of all of the maps. To see only a 
list of maps, first select the Multimedia Source filter.



Graph Media Filter

Select this filter to display a list of all of the articles containing graphs as well as a list of all of the graphs. To see only 
a list of graphs, first select the Multimedia Source filter.



Table Media Filter

Select this filter to display a list of all of the articles containing tables as well as a list of all of the tables. To see only a 
list of tables, first select the Multimedia Source filter.



Sound Media Filter

Select this filter to display a list of all of the articles containing sounds as well as a list of all of the sounds. (Sounds 
are always associated with pictures.) To see only a list of sounds, first select the Multimedia Source filter.



Hot Spot Media Filter

Select this filter to display a list of all of the articles containing hypergraphics (graphics containing hot spots, or links 
to other graphics) and QuickTime VRs as well as a list of all of the hypergraphics and QTVRs. To see only a list of 
hypergraphics and QTVRs, first click the Multimedia Source filter.



Help Button

Click the Help Button on the Toolbar to receive help on that screen. To activate the entire Help program, choose 
Contents from the Help Menu.



Ignore All Button

Choose Ignore All to proceed without changing the spelling of any of the search terms.



Ignore Button

Choose Ignore to proceed without changing the spelling of any of the search terms.



New Folder Button

Click the New Folder Button to add a folder to your Bookmark List.



OK Button

Click this button on the Preferences Window to accept the current preferences.



Open Button

Click this button to open the Subject Index to find articles in the encyclopedias that are related to one another under 
common subject headings. Choose whether you wish to Browse the subject tree or to Search the subject list by 
clicking the appropriate button.



Print Button

The Print Button is located on the Toolbars in Encyclopedia, Dictionary and Media modes. It prints the current article, 
dictionary entry or picture depending on the mode.



QuickSearch    Button

Click this button on the Contents List or on the Media Subject Browser to see a list of all titles in the list containing 
your search term(s). Double click a title to display the item.

 Click here for more information on Quicksearch.



Rename Folder Button

Click the Rename Folder Button to rename a folder in your Bookmark List.



Spelling On Button

The Spelling On Button is found in the Boolean Search or SmartSearch windows, indicating that by default the 
Spelling Button is on.    (Toggle to "Spelling Off" to turn off this feature.)



Encyclopedia Tab

Choose this option to go to the Encyclopedia screen.



Connect Button

Click this button to launch your browser and visit the website you have highlighted.



Contents Button

Click on the Contents Button on the Encyclopedia Screen to display an alphabetical list of the contents of The 
Canadian & World Encyclopedia.



Subject Button

Click on the Subjects Button to display the subject index.



SmartSearch Button

The SmartSearch Button launches SmartSearch, in which you can enter a plain language query or simply a string of 
search terms.



Boolean Button 

The Boolean Search Button opens the Boolean Search window, in which searches can be performed using AND, OR,
NOT and NEAR. 



Back Button

Use the Back Button (located on the Toolbar in Encyclopedia Mode) to move back through the articles you have 
viewed in this session. The list of articles recently viewed can be seen by choosing "History" from the Article Menu in 
Encyclopedia Mode.



Outline Button

Click the Outline Button to display the list of article contents. The contents menu lists all the headings and all the 
multimedia contained in the current article.



Related Button

Click the Related Button in Encyclopedia Mode to activate the Related Menu options. See Related for more 
information.



Random Button

Click the Random Button to randomly display a series of articles from the encyclopedias.



Zoom Button

Click the Zoom Button to display the article in a larger window.    Click the Zoom Out Button to return to the normal 
sized text window. 



Bookmark Button

The Bookmark Button on the Encyclopedia, Dictionary, Media and Timeline Toolbars opens the Bookmark List 
window.



Save Button

The Save Button is located on the Encyclopedia or Dictionary toolbars. It saves the current encyclopedia article or 
dictionary entry.



Tuner Button

The Tuner Button opens the Tuner in the SmartSearch window. The Tuner is used to assign greater or lesser 
importance to terms in a search string.



Zoom Out Button

Click the Zoom Out Button to return to the normal size text window. Click the Zoom Button to display the article in a 
larger window.    



Copy URL Button

Click the Copy URL Button to copy the address of the Internet Link you have highlighted to the clipboard.    Use Paste
to insert the address into your browser.



Apply Button

Click the Apply Button in the Preferences Window to apply the current preferences. See Preferences for more 
information.



Check Box Button

Click the Check Box Button in the Preferences Window to select or to deselect a preference. See Preferences for 
more information.



Media Tab

Click the Media Tab to navigate to Media Mode.



Close Caption Button

Use the Close Caption Button in Media Mode to close the caption.



Legend Button

Click the Legend Button to display a list of all hot spots on the graphic. Note that this button only appears on the 
Media Toolbar when you are viewing a Hypergraphic.



VR Button

Click this button to see instructions on how to use QuickTime VR. Note that this button only appears on the Media 
Toolbar when you are viewing a QuickTime VR.



Caption Button

Click this button on the Media Toolbar to display the caption for the current picture. The button is grayed out if the 
multimedia item has no caption.



Rewind Button

Use this button to move backwards through the multimedia list from the point of the current item. The button is active 
in Media Mode or while the Slideshow is running.



Slideshow Button

Click the Slide Show button to activate the slide show of media from the encyclopedia. When the Slide Show is 
running, this button toggles to the Stop Slideshow Button.



Next Button

Use this button to move forward through the multimedia list from the point of the current object.



Stop Slideshow Button

Click the Stop Slideshow Button to stop the Slide Show. 



Sound Button

Click the Sound Button on the Media Toolbar to play the current sound. Note that all sounds are associated with a 
picture.



Stop Sound Button

Click the Stop Sound button to stop playing the current sound.



Clue Button

Use this button to go to articles in the encyclopedias that contain information related to the current question.



New Question Button

Use this button to skip to a new question in the Quiz.



Hint Button

Use the Hint Button to get a hint about how to solve the puzzle. Note that the button is only activated when all the 
pieces of the puzzle are available.



Jumble Button

Use the Jumble Button to rescramble the puzzle. Note that the button is only activated when all the pieces of the 
puzzle are available.



Solve Button

Use this button to have the computer solve the puzzle for you. Note that the button is only activated when all the 
pieces of the puzzle are available.



Quiz Tab

Click the Quiz Tab to navigate to the Quiz Mode.



Slider

The Slider on the Tuner Window is used to assign greater (slide towards the +) or lesser (slide towards the -) 
importance to your search term.



Timeline Tab

Click this tab to go to Timeline Mode.



Category Button 

Click this button on the Timeline Toolbar to view Timeline events by category.



Period Button

Click this button on the Timeline Toolbar to view Timeline events by period.



Review Button

Click the Review Button on the Timeline Toolbar to display a list of Timeline events from Maclean's magazine.



Firsts Button

Click this button on the Timeline Toolbar to display a list of events describing Canadian landmarks and innovations.



On This Day Button

Click this button on the Timeline Toolbar to find events that happened on a specific day in history.



Search by Date Button

Click the Search by Date Button on the Timeline Toolbar to search for a range of dates in the Timeline.



Show All Button

Click this button on the Timeline Toolbar to return to the main Category or Period screens, showing events from all 
categories or all periods. 



Bookmark Print Button

Click this button in the Bookmark Window to print the current Bookmark list.



Bookmark Help Button

Click this button to get help on the Bookmark screen.



Subject Tree Open Button

Click this button to open the subject tree in the Titles by Subject List. This button toggles (alternates) with the Subject 
Tree Close Button.



Subject Tree Close Button

Click this button to close the subject tree in the Titles by Subject List. This button toggles (alternates) with the Subject 
Tree Open Button.



Basic Button

Click this button in Advanced Boolean Search to return to basic Boolean Search.



Boolean Advanced Help Button

Click this button in Advanced Boolean Help to get help on this window.



Print Preview Button

Click this button to preview a list before you print it.




